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Notice 

This equipment generates and uses radio frequency energy and if not installed and used 
roperly, that is, in strict accordance with the manufacturer’s instructions, may cause 

interference to radio and television reception. 

It has been type tested and found to comply with Part 68 and the limits for a Class B 
computing device in accordance with the specifications in Subpart J of Part 15 of FCC 
Rules, which are designed to provide reasonable protection against such interference in 
a residential installation. 

If the equipment does cause interference to radio or television reception, which can be 
determined by turning the equipment OFF and ON, the user is encouraged to try to 
correct the interference by one or more of the following measures: 

e Reorientate the receiving antenna 

@ Relocate the computer with respect to the receiver 

@ Move the computer away from the receiver 

@ Plug the computer into another outlet so that the computer and receiver are 
on different branch circuits 

If necessary, the user should consult the dealer or an experienced radio/television 
technician for additional suggestions. The user may find the following booklet prepared 
by the Federal Communications Commission helpful: 

"How to Identify and Resolve Radio-TV Interference Problems" 

This booklet is available from the US Goverment Printing Office, Washington, D.C., 
20402. 

Warning 

This equipment has been certified to comply with 68 and the limits for a Class B 
computing device, pursuant to Subpart J of Part 15 of FCC Rules. Only peripherals 
(computer in seth te devices, terminals, printers, etc.) certified to comply with Class 
B limits may be attached to this computer. Operations with non-certified peripherals is 
likely to result in interference to radio and flowin reception. 



interconnecting Cables 

The AC Adapter enclosed in the UltraLite box must be used to connect the UltraLite 
Personal Computer to an AC power source. For connecting peripherals to the Ultra- 
Lite, the following cables must be used: 

@ Modem cables with RJ-11 connectors 

@ Shielded RS-232C Cable (PC-17-97S) with ferrite toroid installed on one end 

Operation without cables described above could violate FCC rules and regulations. 



FCC Requirements 

Type of Service 

Your UltraLite is designed to be used on standard device telephone lines. Connection 
to acoin-service telephone (central-office implemented system) provided by a telephone 
company is prohibited. Connection to party lines service is subject to state tariffs. 

Telephone Company Procedure 

The telephone company may occasionally make changes to their equipment, operations, 
or procedures. If these changes affect your service or the operation of your equipment, 
the telephone company will give you notice, in writing, to allow you to make the necessary 
changes to maintain uninterrupted service. 

If you have any questions about your telephone line, the telephone company will provide 
you with the information on request. In certain circumstances, it may be necessary for 
the telephone company to request information from you concerning the equipment you 
have connected to your telephone line. Upon the telephone company’s request, please 
provide the FCC registration number and the ringer equivalence number (REN) of the 
equipment which is connected to your line. Both of these items are listed on the 
equipment label. The sum of all the RENs on your telephone lines should be less than 
five in order to provide service from the telephone company. In some cases, a sum of 
five may not be used on a given line. 

If Any Problems Arise 

If any of your telephone equipment is not operating properly, you should immediately 
remove it from your telephone line, as it may cause harm to the telephone network. If 
the telephone company notes a problem, it may temporarily discontinue service. When 
practical, the telephone company will notify you in advance of such disconnection. If 
advance notice is not feasible, you will be notified as soon as possible. When you are 
notified, you will be given the opportunity to correct the problem, and you will be 
informed of your fight to file a complaint with the FCC. 

For more information, please contact: 

NEC Home Electronics 

1255 Michael Drive 

Wood Dale, IL 60191-1094 



Software License 

NEC Home Electronics (U.S.A.) Inc. ("NECHE") grants to the customer a non-ex- 
clusive and non-transferable license to use the following software ("The SOFTWARE") 
which is contained in or delivered with the UltraLite. 

The SOFTWARE 

@ ROM BIOS Copyright ©1984-1986 Phoenix Technologies Ltd. 

@ MS-DOS Manager Copyright ©1988 Microsoft 

@ LAP-LINK Copyright ©1988 Traveling Software 

@ SETUP Copyright ©1986,1987 NEC Corporation 

@ EXTENDED BIOS Copyright ©1986,1987 NEC Corporation 

The SOFTWARE means the above computer programs contained in the UltraLite in 
sae (read only memory) format and the manuals which are delivered with the 
UltraLite. 

The SOFTWARE, whether in ROM or another format, is copyrighted and is proprietary 
and trade secret information of Phoenix Technologies Ltd., NEC Corporation, or other 
specified corporations. Said corporations hereby affirmatively retain all rights, title, and 
interest to any copyrights, trademarks, trade secrets, or other proprietary rights in such 
SOFTWARE and manuals in any manner or form. The customer may not, in whole or 
part, copy, modify, reproduce, distribute, sublicense, or sell the SOFTWARE. 

Neither NEC, Phoenix nor anyone else who has been involved in the creation, produc- 
tion, or delivery of the SOFTWARE shall be liable for any direct, indirect, consequential, 
or incidental damages arising out of the use of or inability to use the SOFTWARE even 
if it has been advised of the possibility of such damages or claim. 

Some states or countries do not allow the execution or limitiation of liability for 
consequential or incidental damages so the above limitation may not apply to you. 



Copyright 1988 NECHE. All rights reserved. 

No part of this publication may be reproduced in whole or in part without the prior 
written permission of NECHE and NEC Corporation. The policy of NEC being that of 
continuous improvement, the contents of this manual are subject to change, from time 
to time, without notice. 

All efforts have been made to ensure that the contents of this manual are correct. Should 
you find any errors, however, we shall appreciate it if you notify us. NEC can assume no 
responsibility for errors in this manual or their consequences. 

LAP-LINK is a registered trademark of Traveling Software 

MS-DOS and MS-DOS Manager are registered trademarks of Microsoft Corporation. 

IBM and PS/2 are registered trademarks of International Business Machines Corpora- 
tion. 

Hayes is a registered trademark of Hayes Microcomputer Products, Inc. 



1. Introduction 

1A: Features 

The NEC UltraLite is a truly personal computer. Like other PC compatible computers, 
the UltraLite runs standard MS-DOS software. It reads and writes to the same type 
3,5" diskettes used by the IBM PS/2 family and most all popular laptops, including NEC 
MultiSpeed family of portables. 

Many of the features of the UltraLite surpass those of current desktop computers and 
other laptops. They include: 

@ Built-in MS-DOS 3.3 operating system 

@ Built-in 1 or 2 MB Silicon Hard Disk 

@ Easy to use MS-DOS Manager interface 

@ CPU speeds of 4.92/9.83 MHz 

@ 4.4 pounds (total weight) 

e 2 hour average battery operating time 

@ Built-in 2400/1200/300 Hayes compatible modem 

@ Built-in software to exchange files with other computers (LAP-LINK) 

@ High density 1.44 MB 3.5" floppy drive (optional) 

@ ROM memory card-based applications software 

1.1.1 Built-in Software 

In addition to the Silicon Hard Disk, the UltraLite contains permanent Read Only 
Memory, called the system ROM. All computers have some amount of system ROM, 
but the UltraLite’s ROM, designated Drive D, is quite large. It contains the following 
built-in software: 

e MS-DOS 3.3 

@ MS-DOS Manager 

@ Silicon Hard Disk Utility Programs 

e SETUP Utility 

@ LAP-LINK 

MS-DOS 3.3 

MS-DOS 3.3 is always available on the UltraLite. One of the most useful MS-DOS utility 
programs is the EDLIN editor. It can be used to edit small files and take notes until a 
word processor or programming editor is installed. 
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MS-DOS Manager 

MS-DOS Manager is a DOS shell that simplifies using MS-DOS on the UltraLite. It 
automates many of the tasks performed by DOS commands and provides many features 
offered by extra cost hard disk management software. 

Silicon Hard Disk Utility Programs 

Silicon Hard Disk Utility programs are included in the system ROM to re-initialize and 
format the Silicon Hard Disk and setup MS-DOS Manager. These utility programs are 
only needed to be used one time, unless the Silicon Hard Disk is erased by a power loss 
or if it is to be reformatted. 

SETUP Utility 

The SETUP Utility is a small resident program which allows the user to control the 
processor speed, screen brightness, and other settings. SETUP can also customize the 
use of gray levels on the UltraLite LCD screen. 

LAP-LINK 

LAP-LINK is a file transfer utility used in conjunction with the UltraLite null modem 
cable to exchange files with another laptop or desktop computer. Although LAP-LINK 
is built into the UltraLite, it is necessary to install it on the remote computer. When 
transferring files in LAP-LINK, one of the LAP-LINK floppy disks (3.5" and 5.25") and 
the cable are required. 

1.1.2 A Close Inspection of the UltraLite 
To open the unit, pull forward on the cover latches. 
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Rear Panel 

External 
Disk Drive AC Adaptor Modem Port 

/ Plug 

Telephone RS232C 
Port Port 

The external disk drive port is an NEC proprietary interface between the UltraLite and 
the optional external disk drive and parallel port adapter. These devices provide a 
standard PC parallel port. 

The AC Adapter plug is designed to work only with the NEC AC Adapter provided with 
the UltraLite. 

The RJ11 port marked "LINE" is connected to the telephone network, using the NEC 
modem cable included with the UltraLite. The port marked "TEL" is used to attach a 
telephone unit for convenience while communicating. 

The RS-232C serial port is an NEC proprietary connector that works in conjunction with 
the NEC cables to provide either a serial port compatible with those found in PC/XT 
compatible computers or the IBM PS/2, or a null modem connection to a PC/XT or PS/2. 

Cables provided with the UltraLite: 

@ 9-pin DIN to DB25 (Straight) Serial Cable 

@ Null Modem Adapter (25-pin to 25-pin or 25-pin to 9-pin) 

Bottom Side 

Backup Power 
Switches 

Memo 

Card 
Cover 

Hard Disk 
Cover 

ROM 
Board 
Cover 

Note the location of the Backup Power Switches (remove protective cover). 
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Break Delete 

(= 9 3/0 = a 

| { } a 
nter Back 

Space 

Num 
Lock 

Keys 

The alphanumeric keys follow the standard QWERTY arrangement, but the placement 
of controls and function keys may be different from other PC keyboards. To access the 
built-in numeric key pad, press the NUM LOCK key. 

1.1.3 UltraLite Accessories 

UltraLite 

PC-17-01: UltraLite, 1 MB Silicon Hard Disk Drive 

PC-17-02: UltraLite, 2 MB Silicon Hard Disk Drive 

Accessories 

PC-17-31: Floppy Disk Drive; 3.5" 1.44/720 MB (with parallel printer port) 

PC-17-41; 256K RAM Card 

PC-17-61: Parallel Adapter (allows a printer to be hooked up through the expansion 
port) 

PC-17-85: Carrying Case 

PC-17-71: AC Adapter 

PC-17-73: Molicel Battery Pack 
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1.1.4 Supplement Documentation 

Quick Start Guide 

The Quick Start Guide explains how to unpack and setup the UltraLite. It should be 
read before working with the UltraLite or any of its accessories. 

Portable Guide 

The Portable Guide is a quick reference guide for all of the features and built-in software 
for the UltraLite. 

Comprehensive User Manual 

The Comprehensive User Manual is a detailed reference guide to all of the features and 
built-in software of the UltraLite. It includes tutorial material and menu-by-menu 
procedures for the different applications: MS-DOS Manager, LAP-LINK, and SETUP. 
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1.2. Technical Specifications 

CPU/Memory 

Display 

Mass Storage: 

HDD 

CPU: NEC V30 (8086); Speed: 4.92/9.83 MHz 

Average wait states: 0 wait states 

No co-processor support 

RAM: 640 K at 120 nanoseconds, memory standard 

Screen: Supertwist backlit LCD 

Size: 9.5" diagonal, 640 x 200 pixels 

Dot Pitch: 33 (W) mm x .54 (H) mm 

Dot/inch: 77 (W) x 47 (H) 

(Silicon): 2 MB 

Unformatted Capacity: 1.9 MB 

Access Time: Track to Track 2.4 ms (sequential) and Average 2.0 ms (random) 

Transfer Rate: 87 KB/s 

Interface: Proprietary 8-bit 

HDD Controller: Standard XT 

Interleave Factor: 1:1 

Logical Configuration: 58 cyl. 

Heads: 4 

Sectors/Track: 17 

Bytes/Sector: 512 

Sectors /Cluster: 8 

Read/Write: 

Seek: Typically 120 mA (active) 

Idle: Typically 120 mA (active) 

ROM/RAM Card Slot 

Accepts optional 256 KB/RAM, 512 KB or 1 MB/ ROM cards 

Access Time: Sequential: .025 ms and Random: .025 ms 

Transfer Rate: 534 KB/s 

Power Comsumption: 10 mA 
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Portable Floppy Disk Drive (optional) 
3.5" 1.44 MB Floppy Disk Drive 

Access Time: 

Sequential: 192 ms (720K); 193 ms (1.44MB) 

Random: 192 ms (720K); 193 ms (1.44 MB) 

Data Transfer Rate: 21.6 KB/s 

Number of Bytes/Sector: 512 bytes 

Size: 43/16" (W) x 6 7/8" (D) x 2" (H) 

Weight: 1.78 pounds 

Ports: 

® One 68 pin expansion port (connects to UltraLite) 

@ One 25 pin parallel printer port 

Expansion Port (NEC Proprietary Bus) 

Power Supply: +5 V @ 500 mA, 1.2 A (peak Current) 

Communications: 
Modem: Internal 2400 BPS modem located on the mother board) 

Keyboard 
Style: Desktop equivalent PS/2 derivative keyboard (without the center section); 78 keys, 
12 function, imbedded numeric keypad, separate cursor keypad. LED Indicators: Red 
indicators are integrated in Caps Lock and NUM Lock keys. 

Laptop Ports 

® One 68-pin expansion port (FDD) 

® One 9-pin serial port (9-pin DIN) 

e@ One DC-IN plug 

@ Two RJ-11 modem ports (TEL and LINE) 

@ RAM/ROM card slot 

System Software 

e MS-DOS 3.3 

@ LAP-LINK Version 2 

@ Microsoft DOS Manager Version 2.0 

e SETUP 
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Power Supply: 

AC Adapter: 

Molicel Battery: 

SETUP 

SETUP is an NEC proprietary system configuration utility for the UltraLite. It is used | to change the following parameters: — 

1. Drive Section: SETUP allows the user to select the "B" drive as the bootable drive 

2. Clock Speed: SETUP allows the user to set the clock speed of the CPU at high (9.83 
MHz) or low (4.92 MHz). 

3. Screen: SETUP allows the user to set the following parameters: 
@ Color Mode: Emulation or Contrast 

@ Intensity Mode: Font or Contrast 

@ Default Font: Double dot or Single dot 

@ Backlight: Auto power down (5 min.) high, or low 

@ Palette: SETUP allows the user to select the color pattern 

Modular lightweight 120 V AC Adapter with rechargeable batteries (one Molicel 
Battery and one NiCd Backup Battery). 

Input Voltage: 85 to 132 V 50/60 Hz, .25A 

Output Voltages: DC 5.0 V (0.10A), DC 12.0 V (0.77 A), DC 15.6 V (0.08 A) 

Size: 5.5" (L) x 2.75" (W) x 1.5" (D) 

Weight: 1.20 pounds 

Voltage: 12.6 V ad 

Capacity: 800 mAH 

Watt-Hours: 6.75 

Battery Life/Charge: 2 hours or more depending on use 

Recharging Time: 10-12 hours 

Total Recharge Cycles: 400 

Size: 4" x 2" x 0.5" 

Weight: .397 pounds 

Location: Compartment on bottom side of the UltraLite 
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NiCd Backup Battery: 

System Unit 

Voltage: 3.6 V 

Capacity: 850 mAH 

Watt-Hours: 3.06 

Battery Life/Charge: 7 Days 

Total Recharge Cycles: 300 

Size: 7.75" x 5/8" x 5/16" 

Weight: 0.213 pounds 

Location: Compartment on bottom side of the UltraLite 

The UltraLite’s disk-based SETUP configuration program allows for intelligent power 
management. It is possible to set the LCD backlighting to Auto-Power-Down Mode. 
This programs the UltraLite to turn the backlighting OFF after 5 minutes of keyboard 
inactivity. The UltraLite can also be programmed to use the LCD with full brightness 
or with only half the brightness to conserve power. 

Size: 11.75" (W) x 1.4" (H) x 8.3" (D) 

Weight: 4.4 pounds (not including the AC Adapter) 

System LED Indicator 

Environment 

LOW POWER Indicator: The LOW POWER indicator is located on the leftside of the 
LCD screen. It turns ON to indicate low power. | 

Storage: 

Temperature: 32 deg. F to 122 deg. F (0 deg. C to 50 deg. C) 

Humidity: 20% to 80 % 

Operation: 

Temperature: 41 deg. F to 95 deg. F (5 deg. C to 35 deg. C) 

Humidity: 20% to 80% 
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2. Unit Operation 

2.1. Initial Hardware Setup 

2.1.1 Using the UltraLite for the First Time 
Note: Plug the AC Adapter into an AC wall outlet, then plug the AC Adapter into the 
"DC IN" jack on the UltraLite. This starts the process to charge the batteries. 

1. Turn ON the UltraLite by depressing the "rocker" switch located on the upper 
righthand side of the unit. After a Memory Test, MS-DOS Manager is automatically 
loaded. 

To bypass the Memory Test, press the SPACE BAR. 

If the screen remains too dark or too light, adjust the CONTRAST slide switch, located 
below the screen, until an image appears. 

If the Power On Test reports an error: 

A. Turn the UltraLite OFF. 

B. Repeat the steps in setting up the UltraLite to ensure the CONFIG switches are set 
properly. 

C. Turn the UltraLite ON and OFF three or four more times. If the error condition 
continues, see the Troubleshooting chapter in this manual. 
2. Adjust the screen contrast for best viewing of the Main Menu. 

File Options ta Applications 
Disks: [ A: J [ 

LAPLINK | 
Di Initialize Hard Disk. 

Format System Hard Disk 
ANSI. SYS MANA; Setup DOS Manager 
ASSIGN, COM MANA 
All MGR. 
ALITOEXEC, BAT MODE, 
BACKUP. COM RESTORE, COM 
CHKDSK. COM SETUP, EXE 
COMMAND.COM S¥S,.COM 
CONFIG, §Y§ XCOPY , EXE 
DISKCOPY . COM 
DSET. BA 
EDLIN, COM 
FORMAT . COM 
GRAPHICS, 
IDISK.¢ 
ae a 
LL 

Py ae eatabatatatatatatatetatatattststrtstceetetePeOrsnirestrieieeeteseteieieitBrererare Brera" Svar SVG" STSTSrS'S' O° Cra" Savas aha ontatavavavatatatatetatatatatatatototetatntatatstatetotatatetctctetaatstctcctececttte 

3. The Applications Menu of MS-DOS Manager is highlighted in the center of the 
screen. The following four programs appear in the menu: 

@ LAP-LINK 

@ Initialize Hard Disk 

@ Format System Hard Disk 

@ Setup DOS Manager 

UltraLite Maintenance and Service Manual 11 



2.1.2 Formatting the Silicon Hard Disk 
To properly setup the silicon hard disk, perform the following procedure: 

1. To initialize the silicon hard disk, press the "I" key or press the DOWN ARROW key 
one time followed by pressing the ENTER key. The following message appears: 

WARNING, ALL DATA ON NON-REMOVABLE DISK 
DRIVE C: WILL. BE LOST? 
Proceed with initialize(¥/N)? 

2. Press the "Y" key and then ENTER to begin initialization. 

3. After approximately 30 seconds, initialization is completed, the message "Press any 
key to continue..." appears in the lower righthand corner of the screen. 

4. Press any key to return to MS-DOS Manager. The initial MS-DOS Manager screen 
is displayed: 

File Options Disk Applications 
Disks: CA: 1 C Bi J 

LAPLINK 
Initialize Hard Disk. 
Format austen Hard Disk 

ANSI SYS MANA! Setup DOS Manager 
ASSIGN, COM MANA 
Alita MD 

5. Press the "F" key, or use the DOWN ARROW key to highlight "Format System Hard 
Disk", then press ENTER. The format message is displayed: 

WARNING, ALL DATA ON NON-REMOVABLE DISK 
DRIVE C: WILL BE LOST! 
Proceed with Format (Y/N)? 
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6. Press "Y" and then the ENTER key to begin formatting. Once the Silicon Hard Disk 
is formatted, the UltraLite automatically returns to MS-DOS Manager: 

File Options Disk Applications 
Disks: CA: J CB] 

LAPLINK 
Initialize Hard Disk 
Format System Hard Disk 

ANSI. SYS MANA| Setup DOS Manager 
ASSIGN, COM MANA 
AITO R, 
AUTOEXEC, BAT MODE. COM 
BACKUP, COM 
CHKDSK. COM SETUP, EXE 
COMMAND.COM  S$¥§,C0 i 
CONFIG, SYS XCOPY, EXE 
DISKCOPY. COM 

7. Press the "S" key or use the DOWN ARROW key to highlight "SETUP DOS Manager", 
then press ENTER. 

8. "SETUP DOS Manager" transfers certain necessary files to the Silicon Hard Disk. 

Note: Because the Silicon Hard Disk tranfers files much quicker than a normal disk 
drive, the copy messages displayed on the screen are listed too fast for the user to read 
them. 

9, When the preparation of the Silicon Hard Disk is Sal eye the system automatically 
returns to the MS-DOS Manager. Press ESC to close the Applications Menu. 

10. Simultaneaously press CTRL and "C" to list the files listed on the C: drive (the Silicon 
Hard Disk). 

File Options Disk Applications 
Disks: LAPT EB ITEC lth] 

ALITOEXEC, BAT 
COMMAND, COM 
CONFIG, SYS 
MCR. INI 

11. Simultaneously press CTRL-ALT-DEL to reboot the system. The UltraLite can now 
be booted from the Silicon Hard Disk (Drive C:). 
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12. If the UltraLite was not fully charged, do so now, or the contents of the Silicon Hard 
Disk may be lost. 

Note: When the UltraLite is turned ON, the MS-DOS Manager Application Menu is 
displayed, offering LAP-LINK and any other applications that were added to the 
system. 

File Options Disk Applications 
Disks! [ A! J [ BJ 

LAPLINK 

AUTOEXEC, BAT 
COMMAND, COM 
CONFIG, SYS 

2.1.3 Disk Drive Assignments 
The MS-DOS operating system assigns a letter designation to every storage device on 
the system, treating them all as "disk drives" whether they are actual disk drives or not. 
MS-DOS Manager, lists four logical disk drives in its disk drive line: 

@ Drive A: External 3.5" Disk Drive 

@ Drive B: ROM or RAM Card 

e@ Drive C: Silicon Hard Disk 

e Drive D: System ROM (Initial Boot Drive) 

External 3.5" Disk Drive 

The 3.5" disk drive reads and writes standard MS-DOS disks at densities of 720 K and 
1.44 MB. MS-DOS Manager allows 5.25" disk drives to be formatted at 360 K and 1.2 
MB, but these disk drives are not currently available for the UltraLite. 

DISKCOPY can be used to duplicate disks of the same type using the 3.5" drive, but 
should never be used to copy files to or from the silicon hard disk, ROM, or RAM Cards. 

ROM and RAM Cards 

An important point to remember about these cards is that in order to boot from a card, 
boot tracks must reside on them. Also, neither card effects the main system’s memory. 
Programs are loaded from the RAM and ROM Cards and executed in the main system’s 
memory. 

Silicon Hard Disk 

The Silicon Hard Disk is initialized through MS-DOS Manager. To ier setup the 
Silicon Hard Disk, follow the procedure in the section "Formatting the Silicon Hard 
Disk", 
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System ROM 

The system ROM is the initial boot drive. It contains BIOS information and the 

UltraLite’s version of MS-DOS 3.3. Also, DOS-Manager and LAP-LINK are contained 
in the system ROM. 

2.1.4 CONFIG Switches 

Under normal conditions, the CONFIG switches should never need to be changed. 
Before using the UltraLite, verify the switches are in the default positions (OFF). 

The bank of four switches is found on the right side of the computer, in the same recessed 
compartment as the Memory Card Slot. These four switches control, respectively: 

@ CPU Clock Speed 

e A Built-in Test Program 

e Screen Brightness 

@ Thickness of the characters displayed on the screen 
(Single-Dot, Double-Dot) 
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2.2. Using Peripherals 

2.2.1. Attaching a Disk Drive 
1. Turn the UltraLite OFF. 

2. The floppy disk drive (FDD) is connected to the EXT slot on the rear panel of the UltraLite. 

3. Lift the connector cover up to reveal the EXT port, then attach the end of the FDD 
cable with the core to the UltraLite. 

4. Attach the other end to the FDD. 

5. Connect the UltraLite AC Adapter to the unit. The external disk drive receives power 
from the UltraLite. For the external disk drive to function, the UltraLite must be 
operating from the AC Adapter. 

6. Turn the UltraLite ON, but do not insert a diskette into the external disk drive until 
the MS-DOS Manager screen appears. (If the system finds a diskette in the external 
disk drive when booting, it will attempt to boot from the external drive.) 

File Options Disk Bee cat tons | FizHel Disks; CAPT CB ICC IED) 9:47AM 

ASHEDIT. DOC NC, INT 
ASHEDIT2, DOC NC. MAU 
AUTOEXEC, BAT © SEAGULL. BAS 
COMMAND. COM 

3 

gEEEEEO 
SSESEEL 

| EES 2525255 

SH 
$H 
SH 
SH 
$H 
SH 
SH 
SH 
$H 

Once the system has booted up and the MS-DOS Manager screen appears, the external 
disk drive 1s ready to be accessed. 
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2.2.2 Attaching a Printer (Serial and Parallel) 

The UltraLite can print to either a serial or parallel printer, under the control of an 
application program. 

To print from the UltraLite the following items are required: 

@ UltraLite AC Adapter 

@ An application which supports the printer being used 

e@ Appropriate printer driver 

@ Various cables 

Using a Serial Printer 

To use a serial printer with the UltraLite, also required is one of the following: 

@ The UltraLite serial port cable 

e The optional UltraLite null modem cable adapter 

@ A serial printer cable (if not part of the printer) 

1. Plug the null modem cable into the UltraLite’s serial port. To match the printer’s 
connector, a gender reversing (serial cable and adapter) connector is needed to act as 
a bridge between the 25-pin female connector on the null modem cable and the 25-pin 
female connector normally found on a serial device. 

2. Connect the cable to the printer, following the manufacturer’s instructions. 

3. Serial communications require both the computer and printer to be operating at the 
same speed, parity, and data bits. Check the requirements of the serial printer, then set 
the UltraLite’s serial port by using the MS-DOS MODE command. 

Using the MODE Command 

4. Press the ALT, "F" , and "M" keys in sequence to leave MS-DOS Manager. 

5. The UltraLite’s serial port is always port 1 (COM1:), and the modem is port 2 
(COM2:). The baud, parity, data bits, and stop bits are dependent upon the printer. For 
serial printers, the syntax of the MODE command 1s: 

MODE COM1:baud, parity,data bits, stop bits,P 

Baud can be: 110, 150, 300, 600, 1200, 2400, 4800, 9600, 19200 

Parity can be even (E) or none (N) 

Stop bits are 2 for 110 baud and 1 for all other baud rates. 

"P" causes retry on "time out" errors and is required on many laser printers 

Note: Many serial printers, such as the Hewlett-Packard LaserJet, operate at 9600 
baud, no parity, 8 data bits, and 1 stop bit. 

6. Using the parameters above as an example, at the DOS prompt the user would type: 

MODE COM1:9600,N,8,1,P 

Note: There are no spaces between the characters and the commas. 
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7. Some software programs automatically assume a parallel printer, called LPT1 under 
MS-DOS. If the software does not allow this setting to be changed, the printer output 
can be redirected to the serial port with a second MODE command: 

MODE LPT1:=COMI1: 

This procedure can be automated in two ways: 

A. These MODE commands can be entered into a batch file called SETPRN.BAT (or 
any name the user chooses) and executed under MS-DOS Manager prior to running the 
application. 

B. Add entries in the MS-DOS Manager Applications Menu to do each step. 

8. The printer is now set to print. 

Using a Parallel Printer 

To use a parallel printer with the UltraLite, one of the following is required: 
@ The external disk drive (the parallel port will be used) 

e The parallel port adapter 

1. Connect either the external disk drive or the parallel port adapter to the EXT port 
on the rear panel of the UltraLite. 

2. Connect a standard parallel printer cable between the Parallel port and the printer. 

3. Enter the application program and print. 

Printing Directly From the UltraLite 

The MS-DOS PRINT command does not exist in the UltraLite. To print small files 
directly on either a serial or parallel printer, use the MS-DOS commands COPY 
filename COM1: or COPY filename LPT:. 

2.2.3 Using the Internal Modem 

To use the UltraLite’s built-in modem, a communications program is required. Virtually 
any commercial or public domain communications program can be used. Some of the 
popular communications programs are: 

@ Crosstalk 

e Smart Comm 

@ Telcom 

@e ProComm 

@® QMODEM 

These programs have a complete user applications interface and documentation. The 
interfaces differ widely, but all the programs must do some of the same tasks. The 
procedures below describe the generic tasks. Specific examples assumes a program is 
being used that sends the AT command set to the modem. 

1. Connect the AC Adapter to the UltraLite. 

2. Connect the UltraLite modem cable between the LINE socket on the UltraLite and 
the telephone. Optionally, the telephone cord and the TEL port can be connected. 

Note: Do not use the cords or sockets between the telephone unit and the handset. The 
connectors are deceptively compatible but don’t provide the proper connection. The 
only exception is if the self-contained hand-set telephone is a wall or desk mounted 
cradle (i.e. contains no electronics). 
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3. Start the modem program and select the COM72 as the modem port. 

4. Determine if the telephone service is tone (multi-frequency keying) or dial pulse 
(rotary). Use a "I" for Tone and a "P" for Pulse following the ATDT command (see step 
7). 

5. Determine if any special access codes are needed to obtain a connection, such as 
dialing an "8" or "9" to get an outside line. A comma placed in the dialing string inserts 
a pause to wait for the dial tone of the outside line. One comma causes a two second 
delay. 

Example: AT DT 9,1-XXX-XXX-XXXX 

"X" represents an arbitrary number. 

6. If the user is planning to place credit card calls or use a service such as MCI or Sprint 
that requires special identifier codes before making the connection, it might be easier to 
dial the call manually, then pick up the line with the UltraLite. 

An alternative is to set the dialing string with commas to pause for the various tones. 
The S8 register of the modem controls the length of the pause. To set the pause longer 
than 2 seconds, type: 

AT S8=n (n being the number of seconds for the pause) 

Consult the communications software manual for help. 

7. Enter the number that is to be dialed. 

AT DT 1-XXX-XXX-XXXX 

"X" represents an arbitrary number. 

The user will hear the number dialing, the remote ring and answer, and finally, the carrier 
tone of the two modems before the greeting of the remote system is seen on the screen. 

2.2.4 Charging the System Battery and NiCd Backup Battery 
Before using the UltraLite and thereafter, the batteries need to be charged. Both the 
System Battery (Molicel) and the NiCd Backup Battery recharge at the same time. 

1. Make sure both of the BACKUP POWER switches on the bottom of the UltraLite 
are set to ON. 

Note: Do not use a pencil to remove the protective cover or to set the switches, as 
graphite may damage the switches. 

Backup Power 
Switches 
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2. Check to make sure the computer is turned OFF. 

3. Plug the AC Adapter into the UltraLite first, then into an AC wall outlet. 

4. The CHG and POWER indicators on the AC Adapter are ON when the batteries are being charged. 

Note: The CHG indicator is only used with the Molicel battery. It is only ON while the Molicel is charging. It is not ON when the NiCd battery needs recharging. 

5. When the LOW BATTERY indicator (on the UltraLite) and the CHG indicator turn OFF, charging is completed. The initial charge takes approximately 16 hours, sub- sequent recharging time requires 7 to 10 hours, depending on the state of the batteries. 

Note: The UltraLite can be in operation when the batteries are recharging. 

6. When the batteries are fully charged, disconnect the AC Adapter from the wall first, 
then from the UltraLite. Turn ON the UltraLite. If the LOW BATTERY indicator 
turns ON, continue recharging the batteries. 

Charge Indicator Light 

Power Indicator Light 

Notes on Battery Operation 

The UltraLite has two discrete batteries, a System Battery Mone) and a NiCd Backup 
Battery. The System Battery provides operating power for an average of two hours, 
depending on the application. The NiCd Backup Battery maintains the content of the 
Silicon Hard Disk for approximately five to seven days between charges. 

When the LOW BATTERY indicator turns ON, the UltraLite should be immediately 
turned OFF and the AC Adapter should be attached before further use. The Ultral ite 
should be recharged until the LOW BATTERY and CHG indicators turn OFF. 

If the UltraLite is left uncharged for more than five to seven days, the contents of the 
Silicon Hard Disk may be lost. If the user plans to be away from the UltraLite for more 
than five to seven days, the AC Adapter should be left plugged into the unit. 

If the UltraLite will not be used for an extended period of time, the NiCd Backup Battery 
should be disabled by setting the BACKUP POWER switches (located on the bottom 
of the unit) to OFF. 

The AC Adapter cannot overcharge the batteries. If the UltraLite is needed to be used 
within a day or two of recharging, the AC Adapter should remain plugged in. 
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2.3. System Software 

2.3.1 LAP-LINK 

LAP-LINK is used to transfer files between the UltraLite and another computer. To 
use LAP-LINK, the following is required: 

@ UltraLite 

@ UltraLite Null Modem Cable (Serial Cable and Null Modem Adapter) 

@ Another PC with a serial port 

@ The 5.25" and/or 3.5" LAP-LINK diskettes 

@ Additional cable connectors as required by the other computer. 

When not otherwise specified, the local computer is the UltraLite and the remote 
computer is the other PC. 

For a complete description of LAP-LINK, refer to the "Comprehensive User Guide". 

To Copy a File Using LAP-LINK 

1. With both computers turned OFF, connect the UltraLite null modem cable between 
the UltraLite RS-232C port and the serial port on the remote PC, XT, or PS/2 computer. 
If the remote computer is an AT, a 25-pin female to 9-pin female adapter may be needed. 

2. Turn both computers ON. 

3. Put a LAP-LINK diskette into drive A of the remote computer and copy the "LL.EXE 
file onto the drive and subdirectory (if any) from which files are to be copied. 

Example: If the LAP-LINK program is to reside on drive C, in the subdirectory UTIL, 
at the command line prompt, type: 

COPY A:LL.EXE C:\UTIL 

4. Run the program on the remote computer by typing "LL" from drive C, directory 
UTIL (using the above example). 

If LAP-LINK is in the UTIL subdirectory and the user wishes to run it from another 
directory, enter the command PATH \UTIL in the AUTOEXEC.BAT file. This informs 
the remote computer to look in the UTIL directory. Reboot the remote system. 

Complete instructions on installing and running LAP-LINK are found in the UltraLite 
Comprehensive User’s Manual. 7 
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8. From the UltraLite, use the RIGHT ARROW key to move the highlighted bar to the 

remote window, and the DOWN ARROW key to move the highlight to the file which is 

to be copied from the remote computer. 

9. Press "C", or use the SPACEBAR to move the highlight in the command line to COPY 
and press ENTER. The selected file is copied from the remote computer to the 
UltraLite. 

R 
1 
1 

I 
C 

e] 
b] 

ving SEAGULL, BAS 
ocks 

File(s) Copied 100% Error Free, 
opy complete. Press any key to continue... 
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2.3.2 MS-DOS Manager 

Overview of Menus 

MS-DOS Manager provides pull-down menus that make it easy to use the most common MS-DOS commands. This sections: 

@ Describes each of the four menus in the menu bar at the top of the screen 
@ Shows which menu to use depending on the operation which is to be 

performed 

@ Explains concepts that should be known before executing commands 
The MS-DOS Manager menu bar contains four menus: Files, Options, Disk, and Applications. The name of each menu indicates the type of commands in the menu. When a menu is selected, the commands for that menu appear in a small screen called a pull-down menu. 

The File Menu 

With the File Menu, you can organize and store work files and exit MS-DOS Manager. 

From the File Menu, the following commands can be accessed: 
@ RUN 

@ COPY 

@e DELETE 

e MOVE 

e@ RENAME 

e LOCATE 

@ or get information about a file located on any of the file devices connected to 
the UltraLite. 

To copy files to or from another computer, use the LAP-LINK rogram. To use additional MS-DOS commands, exit MS-DOS Manager. Some of the File commands 
can also be used to work with directories. 

The Options Menu 

The Options Menu allows you to change the way the screen and files appear and the way 
copy and delete operations are performed. 

The Options Menu is used to set the date and time on the computer or add a second 
window to the screen. This menu also saves any changes made to the options or to the 
applications list. 

The Disk Menu 

The Disk Menu allows you to create or change directories, copy or get information about 
a disk, or format a disk. 

The Applications Menu 

The Applications Menu starts applications directly from MS-DOS Manager. Tedious jobs like setting up a serial printer using the MODE command can be automated from the Applications Menu. Modify Options on the Options Menu allows you to add to, 
delete from, and edit the Applications Menu. 
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The following table shows which menu to use for specific operations. 

Selecting the Right Menu 

What You Want to Do Which Menu to Use 

Work with your files: File menu 

Copy 

Delete 

Get information about a file’s size in 

bytes, and the date and time you 

created it or last updated it 

Locate 

Move 

Rename 

Run (executable files) 

Type (the contents of a file) 

Work with your directories: File or Disk menu 

Change directories Disk menu 

Copy File menu 

Create Disk menu 

Delete File menu 

Locate File menu 

Rename File menu 

Install or modify your applications Options menu 

Split your screen Options menu 

Specify how files are shown: Options menu 

Whether files should be listed 

alphabetically, by date, by extension, 

or by size 

Which files should be listed 

Whether files should be listed in short 

or long format 

Safeguard against overwriting by Options menu 

mistake 

Safeguard against deleting by Options menu 

mistake 

Verify copy operation Options menu 

automatically 

Specify certain Help options Options menu 

Set the date and time Options menu 

Exit to MS-DOS File menu 
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Getting Help 

Pressing the F1 function key gives help information for the operation being performed. MS-DOS Manager responds by displaying a help screen. 

For Example, if the Create Directory command was being used and the F1 function key was pressed, MS-DOS Manager would respond with the following screen: 

File Options Disk Applications 
Disks: [Ai ] 

Create Directory... 
Create Directory Command Page (1 of 1) 

[XT} Use this command to make a new divectory in the current ALT reed le (unless you specify a different drive or CHK) directory), The Create Directory Dialog box contains the 
oie following field: 

GEM] Create Directory: [I||] «Type the name of the directory GEM; that you want to create. This name can contain the drive MGR} letter and a colon, followed by the new directory name, For NC.| example, to create a directory BUDGET on drive B, you would type bi\budget. If you want to create a new subdirectory ALCUST in you current directory, you would simply type august, 

( Next PoDn> (Back Pgllp) (Index? (Cancel) t 

et 

Press Return for more help or press Esc to resume 

Accelerator Keys 

By pressing the ALT kcy or looking at any of the pull-down menus, it can be seen that one letter in the name of each menu, command, or application is highlighted. The corresponding key on the keyboard is called the accelerator key. By pressing the accelerator key, that menu or command is selected. 

A selection can be made from a menu or a pull-down menu by pressing the accelerator key. 

Dialog Boxes 

If MS-DOS Manager needs to know more information about a selected command or application, a dialog box appears on the screen. 

A Dialog Box asks the user to do one of the following: 

@ Type in information 

@ Select one of several options from a list 

® Set or clear an "on/off" option 

@® Confirm a command 
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Type In Information 

A Dialog Box may ask the user to type in the name of a file, directory, drive, or path. 

For example, the COPY Dialog Box asks the user to supply the new name for the file 

being copied: 

File Options Disk Appl ications 
Disks: CAV TE B Tie it be] 

[XTALK] 
ALITOEXEC, BAT 

Copy 

EXTALKL TTT EEEEEEEEEEEEE 

CHET 

« OK > <Cancel> 

ore ere Nc acezeatces sce Scec Can 
Peceasneceseenencncen 

Select One of Several Options From a List 

This type of Dialog Box asks the user to choose from a list of options. 

For example, the File View Options Dialog Box asks the user to choose the format the 
files should be listed in: 

File Options Disk ee 
Disks: CA: JOB Yi Cr; 2 De 

File View Options 

CXTALK] 
AUITOEXEC, BAT 
CHKDSK. COM 

Select the options and press Return or press Esc to cancel 
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Set or Clear an "ON/OFF" Option 

This type of Dialog Box gives a yes/no choice on one or more options. [ 

For example, the Copy Options Dialog Box lets the user set or clear the Confirm File 
Overwrite Option: 

File Options Disk Applications 
Disks: CAP TEBE ee Te De 

(XTALK] 
AUTOEXEC, BAT 
CHEDSK, COM 

Copy Options 

(X] Confirm File Overwrite 

(X] Verify Copy 

( OK > <Cancel) 

Confirm a Command 

This type of Dialog Box asks the user to confirm a command. 

For example, the MS-DOS Manager Dialog Box asks the user to confirm whether or not 
you want to exit to the MS-DOS Manager command line: 

File Options Disk Applications 
Disks: [ALT CBS IOC TT Dt 

CXTALK] 
AUTOEXEC, BAT 

Press Return to finish the MS-DOS Manager session or press Esc to cancel 
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Executing Commands 

To execute any of the MS-DOS Manager commands explained in the following menus, 

the user may need to perform up to four steps: 

1. Select a file or directory. 

2. Select a menu. 

3. Choose a command or application from the pull-down menu. 

4. Complete the dialog box (if necessary). 

Step 1: Select a File or Directory 

Step 1 is used if a command that operates on files and directories (COPY, DELETE, or 
MOVE) is used. Otherwise, proceed to Step 2. 

1. If the current directory does not contain the file or directory wanted, change to the 
directory where it is located. 

To change directories, use the CHANGE DIRECTORY command in the Disk Menu. 

2. Select the desired file or directory by using the ARROW keys to move the highlighted 
bar over the file or directory name. 

Keyboard Shortcut 

Move the highlighted bar over the desired file or directory by pressing the first letter of 
the file or directory name. 

Pressing the letter key once, the highlighted bar moves to the first filename that begins 
with that letter. To continue moving the bar down, press the key again or use the 
ARROW keys. 

Selecting Multiple Files 

To select more than one file to move, copy, or delete: 

1. Using the ARROW keys, move the highlight to the first desired file. 

2. Hold down the SHIFT key and press the UP or DOWN ARROW Key to select a file 
or files above or below the highlighted one. 

3. Choose the desired command that is to be carried out on all of the selected files from 
the File Menu. 

4. Press ENTER to execute the command. 

To select multiple files not listed one right after the other: 

1. Use the ARROW keys to highlight the first file. 

2. Hold down the SHIFT key while: 

e Using the ARROW keys to select the files listed right after each other. 

e Pressing the SPACEBAR to remove the highlight from a file that is not to be 

selected. 

e Using the ARROW keys to move to the next desired file. 

@ Pressing the SPACEBAR again to resume selecting files. 

The SPACEBAR acts as a toggle switch, alternating the highlight ON and OFF. 
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Step 2: Select a Menu 

fC 7 
This step "pulls down" one of the four MS-DOS Manager Menus on the screen. 

1. Press ALT. 

2. Highlight the desired menu bar by using the RIGHT and LEFT ARROW keys. 

3. Press ENTER. 

The pull-down menu appears on the screen. 

Keyboard Shortcut 

1. Press ALT. 

The menu bar is activated. 

2. Press the first letter of the desired menu. 

The pull-down menu appears on the screen. 

Step 3: Choose a Command 

This step informs the MS-DOS Manager which command or application is to be used. 

1. Highlight the desired selection in the pull-down menu by using the UP and DOWN 
ARROW keys. 

2. Press ENTER. 

OR 

Press the accelerator key for the command (or application) desired. tS 

Cancelling a Command 

To cancel a command and return to the MS-DOS Manager, press ESC. 

After a choice is made from the pull-down menu, the MS-DOS Manager does one of the 
following: 

@ Executes the command selected. 

@ Starts the application selected. 

@ Displays a dialog box asking for more information. 

Step 4: Complete the Dialog Box 

When a Dialog Box appears, MS-DOS Manager needs more information from the user; 
select one of several options from a list, set or clear an ON/OFF option, or confirm a 
command. 

It may be necessary to move between fields to complete a Dialog Box. 
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A Dialog Box can have several parts, or fields. To move from one field to another, one 
of the following options is used: 

Moving between fields 

To move Do this 

To the next field Press TAB. 

To the previous field Press SHIFT and TAB at the same time. 

To any field Press ALT. One letter in each field of the dialog box is 

highlighted; type the highlighted letter in the field you 

want to move to. 

Entering Information 

There are four ways to enter information in a Dialog Box: 

1. Type in the text. 

2. Select on of several options in a list. 

3. Set or clear an ON/OFF option. 

4. Confirm a command. 

Typing Text in a Dialog Box 

The keyboard is used to type text in a Dialog Box, such as a filename. 

Selecting One of Several Options From a List 

In a Dialog Box showing a list of options that can be set or cleared, the currently selected 
option shows an asterisk (*). To choose a different option in a Dialog Box: 

1. Position the highlighted bar over the desired option. 

Use the UP and DOWN ARROW keys, or if the option has a highlighted letter, just type 
that letter. 

2. Set or clear an option by pressing the SPACEBAR. 

Setting or Clearing an ON/OFF Option 

In a Dialog Box showing options that can be turned ON or OFF, if the option is selected, 
an "X" appears in the brackets next to the option. 

To either set or clear an option: 

1. TAB to the desired option. Press the SPACEBAR. 

2. If the brackets are empty, an "X" appears and the option is set. If there is already an 
"X" in the brackets, the "X" disappears and the option 1s cleared. 
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Confirming a Command 

When MS-DOS Manager displays a Dialog Box asking to confirm a command, the user | 
can either execute or cancel it at that point by executing or cancelling the Dialog Box. 

To execute a Dialog Box, press ENTER. 

To cancel a Dialog Box, TAB to the cancel field and press ENTER or press ESC. 

To Scroll Through a List of Files and Directories 

The scroll bar (at the bottom or to the right of the screen) contains a highlighted 
rectangular box that shows where the user is in the list of files or directories as they scroll. 
This box 1s the Scroll Bar Indicator. It shows the relative position in the directory. A 
mouse can be used to move the Scroll Bar, although the mouse is not recommended for 
use with the UltraLite. 

See the table below for ways to view files on the UltraLite. 

To scroll through a list of files 

To move 

Up or down one line at a time. 

Up or down one screen at a time 

To the beginning or end of the file list 

Moving Around in Your Directory System 

Do this 

Use the arrow keys. 

Use the PG UP and PG DN 

keys 

Use the HOME and END keys. 

You Can move around in the 

multilevel system by starting 

at the root and traveling 

through directories and 

subdirectories to find a { 

particular file. Conversely, 

you Can start anywhere 

within the file system and 

travel toward the root. 
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Changing Directories 

There are three ways to change the current directory: 

1. Use the Change Directory in the Disk Menu. 

2. Select the MS-DOS or EXIT commands (from the File Menu) to get to the MS-Dos 
system prompt. Type "CD" and the pathname at the system prompt. 

3. Use the ARROW keys. 

If the disk in the floppy drive is changed, MS-DOS Manager must be informed. To do 
this, hold down the CONTROL key and press the key corresponding to the drive letter. 
The MS-DOS Manager displays the files and directories on the new floppy disk. 

To change to Do this 

Subdirectory of Current Directory Use the arrow keys to 
highlight the name of a 

subdirectory listed on the 

screen. Press ENTER. 

Parent Directory of Current Directory From the screen showing the 

list of files in your current 

directory, press the 

BACKSPACE key. 

Last Current Directory on Another Drive Hold down the CTRL key and 

press the drive letter of the 

other drive. 

The following table is a summary of the functions performed in MS-DOS Manager by 
specific keys or key combinations. 

Important keys 

Key Function 

ARROW Keys (Cursor or Directional Keys) used to move around on the screen 

one space at a time. 

SPACEBAR used as a toggle switch to turn highlight on or off while selecting 

multiple files or to set or clear options in dialog boxes. 

TAB used to move around in jumps. If you hold down the SHIFT key 

while pressing the TAB key, cursor jumps back. 

INSERT inserts the text held in the buffer in the place indicated by the 

cursor. 

DELETE removes highlighted text to a holding buffer. Text is held only 

until the next use of the DELETE key. 

HOME moves cursor to the start of the line. Hold down the Fn key 

while pressing the HOME key to activate. 

END moves the cursor to the end of the line. Hold down the Fn key 

while pressing the END key to activate. 

ENTER used to start carrying out a command. 

ESC (Escape) used to cancel something. 

ALT (Alternate) used to alter the function of a key. In MS-DOS 

Manager, pressing ALT highlights a key letter in the menu to 

allow selection of a command. 

CTRL (Control) also alters the function of a key. To change drives 

quickly, hold down the CTRL key and press letter of desired drive. 

Fn (Function) used to activate the functions printed in red on 

certain keys (HOME, END, PAGE UP, PAGE DOWN, etc.). 

Function Keys (F1, F2, F3,...,F12) Each key has an associated function used as a 

shortcut to enter DOS commands. See sections above for more 

information. 
NN 
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2.3.3 SETUP 
SETUP isa utility built into the UltraLite. Its purpose is to allow the user to alter certain [ parameters, such as the processor’s clock speed, how colors are displayed on the LCD screen, and the drive sequence for booting the operating system. 

The UltraLite is preset with most of the common settings, they may not need to be altered. However, certain application programs may require a slower clock speed or 
different characteristics. 

Starting SETUP 

SETUP is loaded automatically from the AUTOEXEC.BAT file when the UltraLite is 
turned ON or rebooted. To activate it, a special "hot key" combination (CTRL-ALT-S) 
must be pressed. 

To activate SETUP: 

Press the CTRL-ALT-S keys simultaneously. The following screen appears: 

ev? 1.) SIT I|P MAIN SCREEN 
(BOOT FROM B:) Yes No 
(CLOCK SPEED) High Low 
« SCREEN) 

Color mode Emulation Contrast 
Intensity mode Fon ontrast 
Default Font Doubledot aoe 
Backlight Auto(Smin) Hig Low 

Palette C @134254601342546 1] (Intensity level) 

xeee Color Pattern s#HH 

ea 

ae] ae] Oey ey ay ey ey 

1 
a 
3 
4 
) 
6 
? my 

The current settings are displayed within the box of double lines. Directly beneath the 
box is the Command Line, a Help Line which explains each command, and a Prompt 
Line which reminds the user of the current options. 

To Select a Command 

1. Either press the first letter of the command, or use the SPACEBAR or BACKSPACE 
keys to highlight the specific commands. As each command is highlighted, the Help 
Menu offers a brief description of it. 

2. Press ENTER to select a highlighted command. 
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SETUP Command Descriptions 

BOOT 

The BOOT command changes the MS-DOS boot sequence, allowing the UltraLite to 

boot either from drive B, the RAM Card, or drive C (Silicon Hard Disk). In any case, 

if the external drive A is connected and it contains an MS-DOS System Diskette, the 
UltraLite will always boot first from drive A. 

In most cases, the users wants the system to boot from drive C (Silicon Hard Disk). The 
There can only boot from drive B if the 256 KB RAM Card is present, and it contains 
the MS-DOS system files. If no card is inserted, the UltraLite will attempt to boot from 
drive C. 

Boot from Drive B: ? Yes No 
Select "No" to set the boot sequence Ai-)Ci->D: 

Select "Yes" op "No" and press ENTER, > 

Note: Do not change this setting to "Yes" unless the Memory Card Slot contains a RAM 
Card with MS-DOS system files installed on it. 

Recovering From Boot Error 

If an attempt to boot from drive B is made, and the Memory Card Slot contains a ROM 
Card or a RAM Card without system files, the following error message appears: 

"Non-System Disk or Disk Error. 

Replace and strike any key when ready." 

If a RAM Card with MS-DOS system files is available, turn the UltraLite OFF and 
replace the Memory Card. Otherwise, the UltraLite will have to be reset and return all 
of the parameters to their default settings by simultaneously pressing CTRL-ALT-DEL. 

CLOCK 

The CLOCK command toggles CPU speeds. High speed is 9.83 MHz and low speed is 
4.92 MHz. Very few applications require the lower clock speed anymore, some older 
applications might. 

Note: If the clock speed is changed from the SETUP Menu, keep in mind that the 
CONFIG SW 1 overrides this setting upon rebooting or power-up. For example, to set 
the clock permanently to the lower speed, CONFIG SW 1 must always be set to ON. 

iv ll 16 15 14.19 Lb Lf 18 19 LH LB AL LY Ln Lt 
26 21 22 23 24 25 26 27 28 29 2A 2B 2C 2D 2E eF 
36 31 32 33 34 35 36 37 38 39 3A 3B 3C 3D 3E 3K 
4 41 42 43 44 45 46 47 48 49 48 4B 4C 4D 4E 4F 
5@ 51 52 53 5455 56 57 58 59 5A SB SC SD SE OF 
66 61 62 63 64 65 66 67 68 69 6A 6B 6C 6D 6E OF 
76 71 72 73 74°75 76 77 78 79 7A 7B 7C 7D 7E ?F 

CPU clock speed: High Low 
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Press "H" for High or "L" for Low in order to change the clock speed. 

Note: To toggle between clock speeds without entering the SETUP Program, press 
CTRL-ALT-H to select the high speed or CTRL-ALT-L to select the low speed at any 
time. 

EXIT 

The EXIT command exits from the SETUP program, and saves the changes made. 
Before exiting, a question concerning leaving SETUP and saving the changes is asked. 

Press "E" for EXIT. 

QUIT 

The QUIT command exits from the SETUP program without saving the changes. 
Parameters set before the current session remain in effect. Before quitting, a question 
concerning quitting SETUP without saving the changes is asked. 

Press "Q" for QUIT. 

SCREEN 

The SCREEN commands affect the way in which graphics, text, and colors are displayed 
on the UltraLite screen. The SCREEN command brings up a submenu with six submenu 
commands: 

{COLOR MODE) Emulation Contrast 

(INTENSITY MODE> = Font Contrast 

(DEFAULT FONT) Doubledot Singledot 

«BACKLIGHT > Auto(Smin) High Low 

(PALETTE) C @134254601342546 1] (Intensity level) 

eee Color Pattern sue 

baey aeg seg Osry hey ary ey 

ie] 

The current choices for screen display characteristics are displayed within the box of 
double lines. 

During any application, simultaneously pressing CTRL-ALT-S, goes into SETUP. 
Screen parameters can be changed and then resuming to the current application allows 
the new screen parameters to be seen. 

Note: SETUP is a TSR program (Terminate and Stay Resident). Not all applications 
work with TSR programs and some TSR programs do not work with each other. Test 
the CTRL-ALT-S combination with an application. If the application "hangs-up" when 
SETUP tries to pop up, reboot the sytem. 
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SCREEN Submenu Commands 

BACKLIGHT 

The BACKLIGHT command effects the brightness of the screen and also the time the 
UltraLite can operate using the built-in battery. 

Press "B" for BACKLIGHT. 

Auto is the default setting, it allows the screen to operate at full backlighting while in use 
and switches automatically to the "energy-saving" low backlighting after five minutes of 
keyboard inactivity. Pressing any key brings the screen back to full brightness. 

High setting keeps the screen at full brightness all the time. Best used when operating 
from the AC Adapter. 

Low setting keeps the screen at a constant low brightness, for maximum energy savings. 
Using this setting can extend battery life. 

SCREEN 
{COLOR MODE) Emulation Contrast 
{INTENSITY MODE) on Contrast 
{DEFAULT FONT> Doubledot TH 
< BACKLIGHT > Auto(Smin) Hig Low 

To select Auto, High, or Low, press the first letter (A, H, or L). 

COLOR 

The COLOR command emulates a color screen (CGA resolution) in order to work with 
the greatest array of MS-DOS software (but can’t actually display colors). The COLOR 
command allows the selection of Emulation or Contrast mode. 

Press "C" for COLOR. 

Emulation 

In the Emulation mode, pixels are either ON or OFF, and are at a uniform brightness 
level. This means the colors in the color software are displayed with simple alternatives, 
such as reverse video, single dot characters, white background, and bold. Emulation is 
sufficient when working with text and black/white graphics. 

Contrast 

In the Contrast mode, colors are individually mapped into different intensities or "grey' 
shades. Using the PALETTE command, a level from 0 to 6 can be assigned to any of 16 
colors. If the application demands a realistic representation of different colors, the 
Contrast mode should be used. 

To select the Emulation or Contrast mode, press the first letter of the mode (E or C). 
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Checking the Software 

Many software publishers now recognize the wide-spread use of laptop computers, and 
their software may have a laptop or black/white screen mode. Before experimenting 
with the SETUP SCREEN commands to improve legibility, check the software manual. Also the term "monochrome" usually refers to an MDA or a Hercules-compatible 
controller which drives a monochrome monitor and does not pertain to the UltraLite. 

EXIT 

The EXIT command goes back to the original SETUP Menu, a level above the Screen 
Menu. 

Note: The changes selected will become permanent only when exiting from SETUP. 

Press "E" for EXIT. 

FONT 

The FONT command allows the UltraLite to display standard characters in double-dot 
or single-dot fonts. 

Press "F" for FONT. 

Double-Dot 

Characters are composed of lines of two pixels in width. Text in Double-Dot will look darker on the screen than in Single-Dot. 

Single-Dot 

Characters are composed of lines of one pixel in width. 

To select Double-Dot or Single-Dot, press the first letter of the desired font (D or S). 

INTENSITY 

The INTENSITY command controls how to display emphasized and colored text 
characters. 

Press "I" for INTENSITY. 

FONT allows the alternative font, Double-Dot or Single-Dot, to represent an em- 
phasized character. 

Contrast is equivalent to "Contrast" in the COLOR command. All emphasized charac- ters are assigned shades of darkness, or contrast, and the font remains unchanged. The darkness level can be changed with the PALETTE command. 

To select Font or Contrast, press the first letter of the desired INTESITY command (F or C). 
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PALETTE 

The PALETTE command allows the UltraLite to emulate a CGA color monitor, which 
may be useful when displaying business graphics. 

For example, in graphics which use a number of colors that are not easily distinguishable 

on the UltraLite display, the PALETTE command can be used to increase the contrast 
among the colors. 

Note: The PALETTE command cannot be activated when the Emulation Color mode 

is selected. 

The PALETTE command allows the intensity level to be assigned between 0 to 6, 0 being 
the darkest and 6 being the lightest, to each of 16 colors, numbered hexidecimally 0 to 
F, 

TUP 1,88 SCREEN 
{COLOR MODED Emulation Contrast 
{INTENSITY MODED Font Contrast 
{DEFAULT FONT? Doubledot TH ea 
{BACKLIGHT > Auto(Smin) Hig Low 

Palette number 'OLi23 456789 ABCDEF 

Intensity(@. .6) (0134254601342546 EXIT 

The Palette Number line never changes and serves as a reference to the Intensity line, 
which has a user assigned value of 0 to 6, 0 being the darkest and 6 being the lightest. 

The following table shows the which CGA colors correspond to which palette number 
and their default intensity. 

Palette Color Intensity Table 

Palette# + +«CGAColor __—iIntensity(default) st sti—i—S 
black 0 

blue 

green 

cyan 

red 

magenta 

brown 

light gray 

dark gray 

light blue 

light green 

light cyan 

light red 

light magenta 

light yellow 

white Mmoponwmrvd DNAY HRWN FO ARM N KRWOKF ODA KYW N AH WE 
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Adjusting Intensity Level 

1. Press "P" for Palette. 

2. Use the SPACEBAR and BACKSPACE keys to move the highlight bar from one 
palette number to another. 

3. The ARROW keys are used to raise or lower the highlighted value between 0 and 6. 

4. After adjusting the contrast, press "E", or move the highlighted bar to Exit and press 
ENTER. 

Color Patterns 

The Color Pattern table demonstrates how two "colors" will appear together. When any 
values in the Palette/Intensity Line are changed, the result is in the Color Pattern table. 
The left digit indicates the background color and the right digit indicates the foreground 
color. 

oH Color Pattern sae 

GG G1 @2 G3 B4 O5 G6 B7 B8 G9 GA GB GC BD GE OF 
1@ 11 12 13 14.15 16 17 18 19 1A 1B ic iD LE IF 
26 21 22 23 24 25 26 27 28 29 2A 2B 2C 2D 2E 2F 
38 31 32 33 34 35 36 37 38 39 3A 3B 3C 3D 3E BF 
4@ 41 42 43 44 45 46 47 48 49 44 4B 4C 4D 4E 4F 
28 31 52 53 5455 56 57 58 59 5A 5B 5C SD SE OF 
68 61 62 63 64 65 66 67 68 69 6A 6B 6C 6D 6E 6F 
78 71 72 73 74:75 76 77 78 79 7A 7B O7C 7D VE OF 

2.3.4 MS-DOS Manager 3.3 

Initial AUTOEXEC.BAT file 

The initial AUTOEXEC.BAT file is as follows: 

PATH D:\ 

SETUP 

SET COMSPEC = D:\COMMAND.COM 

MANAGER C:MGR.INI 

Notes: 

PATH D:\ - Searches the D drive and the current directory for all executable files. 

SETUP - Loads the TSRprogram used to set the processor speed, change the backlight 
brightness, and other features. SETUP is activated by hitting the ALT-CTRL-S keys. 

SET COMSPEC = D:\COMMAND.COM - Specifies the path to reload COM- 
MAND.COM when necessary. 

MANAGER C:MGR.INI - Starts MS-DOS Manager every time the UltraLite is powered 
up or reset. If MS-DOS Manager was used before, the parameters are saved in 
MGR.INI. 
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UltraLite DOS vs MS-DOS 3.3 

Several of the MS-DOS 3:3 files are not used by the UltraLite. Most of these files refer 

to devices not supported by the UltraLite. Also, any commands, such as DISKCOMP, 
are not used by the UltraLite because the "disk drives" are not similar devices. 

All of the normal internal commands (DIR, CD, TYPE, etc.) are available. The 
UltraLite has some files not found in MS-DOS 3.3. These files are located on the D 

drive (System ROM) and cannot be deleted. 

MS-DOS files not found in the UltraLite 

APPEND.EXE 

ATTRIB. EXE 

COMP.COM 

COUNTRY.SYS 

DEBUG.COM 

DISKCOMP.COM 

DISPLAY.SYS 

DRIVER.SYS 

FASTOPEN.EXE 

FDISK.COM 
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FIND.EXE 
GRAFTABL.COM 
JOIN. EXE 
KEYB.COM 
KEYBOARD.SYS 
MORE.COM 
NLSFUNC.EXE 
PRINT.COM 
PRINTER.SYS 
RECOVER.COM 

REPLACE. EXE 

SELECT.COM 

SHARE. EXE 

SORT.EXE 

SUBST.EXE 

TREE.COM 

VDISK.SYS 

EGA.CPI 

LCD.CPI 

4201.CPI 

5202.CPI 
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The following table lists all of the MS-DOS files and programs available on the UltraLite. 
These files are on the system ROM and cannot be deleted or altered. | 

UltraLite MS-DOS files 

File name 

ANSILSYS 

ASSIGN 

AUTO 

AUTOEXEC.BAT 

BACKUP.COM 

CHKDSK.COM 

COMMAND.COM 

CONFIG.SYS 

DISKCOPY.COM 

DSET.BAT 

EDLIN.COM 

FORMAT.COM 

GRAPHICS.COM 

IDISK.COM 

LABEL.COM 

LL. EXE 

MANAGER.EXE 

MANAGER.HLP 

MANAGER.INI 

MGR.INI 

MODE.COM 

RESTORE.COM 

SETUP.EXE 

SYS.COM 

XCOPY.EXE 

DUMMY1 

DUMMY2 

10 

MSDOS 

* = unique to UltraLite 

Function or task 

standard screen driver 

redirects disk drives 

* batch file for drive C 

* batch file for drive D 

standard backup utility 

check disk status 

system file 

* copied to drive C 

useful for backing up 3.5" diskettes 

* installation file 

text editor 

formats 3.5" diskettes 

screen print 

* similar to FDISK 

display or alter volume label 

LAP-LINK file transfer program 

MS-DOS Manager program 

MS-DOS Manager help files 

* system file 

* copied to drive C 

redirects output 

used with BACKUP command 

* memory resident utility program 

system file 

copies files by directories 

(hidden file) 

(hidden file) 

(hidden file) 

(hidden file) 
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2.4. ROM and RAM Cards 

Many popular software programs are available from NEC on ROM cards. By far, a 

ROM card is the most convenient way to carry and install software in the UltraLite. 
Diskless software is always available and cannot be erased from memory. 

ROM Card Insert in Direction Thumb Grip 
Connector of Arrow 

Another way to carry files without a disk drive is the 256 KB RAM Card. Software can 
be loaded onto the RAM Card. The RAM Card can also be used to temporarily backup 
the Silicon Hard Disk. 

Insert in Direction Thumb Grip 
of Arrow 

pros Write 
rote Protect 
Switch Position 

Write 
Enable 
Position 

SOSOCOSSHOOOHOSESHHOHSSSEOESEEOOBE SOCOHSHSSSEHSOHSHOSSHSHOHSSSHOHHOSSHSCOES 

Lithium 
Battery 

RAM Card Connector Battery Compartment (Reverse) 
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Inserting a ROM Card 

When inserting a ROM Card, the UltraLite may be ON or OFF. The card is always inserted with the thumb grips to the right of the slot. This allows for easy removal of the 
card from the unit. 

1, Remove the Card Slot Cover from the UltraLite by pulling gently. 

2. Carefully handle the ROM Card, avoiding touching the metal contacts. Insert the 
card into the slot until the connectors "catch". 

ZL 

3. From the MS-DOS command line, type B:(Program Name) to run the program. Or, 
install it in the Applications Menu of MS-DOS Manager, following the instructions in 
the MS-DOS Manager. 
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Inserting a RAM Card 

No Follow the same steps as inserting the ROM Card. 

in Position 

Write-Protecting the RAM Card 

Data or programs stored on a RAM Card can be protected by "write-protecting" it. The 
card will then be "read only", and new data cannot be written to the RAM Card. 

1. Removal of the RAM Card from the UltraLite is not necessary when write-protecting 
it. 

2. Using a pen tip or small instrument, move the small white switch on the end of the 
card from the left to the right. 

Write Write 
Protect Pie 
on ae osition 

Write 
Protect  — 
Switch 
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Replacing the RAM Card Battery. 

The lithium battery in the RAM Card is guaranteed for six months, but may last longer. L 

Always replace the lithium battery with the same or equivalent battery type. 

1. When replacing the battery, there is only 10 seconds to work with before data on the 
card is lost. Replacement should take approximately 2 or 3 seconds. 

2. Turn OFF the computer and remove the RAM Card. 

3. Using a small screwdriver, remove the battery case from the card. 

Groove 
S \ 

\ 
\ 

4. Place the new battery in the case with the top, or flat, side exposed and the rounded 
bottom side seated in the case. 

3V Lithium 
Battery —_ 

Bottom 
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5. Insert the case back into the card, making sure it is not upside down. (The rounded 
edge is to the outside.) 
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3. Theory of Operation and 

Troubleshooting 

3.1. Circuit Board Description 

MAIN PWB 

The MAIN PWB contains the V-30 CPU, 640K RAM, Interrupt, Serial, Parallel, LCD 

Controller, and the Internal 2400BPS Modem circuits. Also contained on the MAIN 

PWB is a "soldered-on" circuit board (Power Control PWB). The Power Control PWB 

controls both batteries and the sensing of low power. When replacing the MAIN PWB. 

it is not required to remove the Power Control PWB. 

ROM PWB 

The ROM PWB contains the 512K system ROM, where the BIOS information, MS-DOS 
3.3, DOS Manager, and LAP-LINK are located. 

Silicon Hard Disk (MMC-253) 

The Silicon Hard Disk is available in 1-Megabyte (PC-17-01) or 2-Megabyte (PC-17-02) 

versions. The Silicon Hard Disk is accessed as the logical C: Drive and is backed up by 

the NiCd Battery. Data can be held on the Silicon Hard Disk for 5 to 7 days. The 

1-Megabyte version is identified by p/n HMC-253C and the 2-Megabyte version is 
identified by p/n HMC-253B. 

KEYBOARD ASSEMBLY 

The KEYBOARD Assembly is a full 78-key keyboard with 12 function keys and an 
enbedded keypad. There is a separate pad to control the cursor (ARROW Keys). Also 
on the keyboard is a key labeled "Fn", which is used to activate the functions printed in 
red on the keys (HOME, END, PAGE UP, PAGE DOWN , etc.) All of the control logic 
for the keyboard is contained on the keyboard. The keyboard is equivalent to a PS/2 
derivative keyboard. 

RAM and ROM Cards 

The 256 K RAM Card (PC-17-41) and the ROM Card can be accessed as the logical B: 
Drive. 

Note: The system files must be on the card in order to boot from the card. 

The RAM Card contains a lithium battery which backs up the data for at least six months. 
The voltage rating on the lithium battery is +3 V. It consumes less than 10 uA. 

Data on the card can be protected by setting the WRITE-PROTECT switch. The switch 
is located on the end of the RAM card and the WRITE PROTECT mode is activated 

by moving the switch from the left to the right. 

Molicel Battery Pack 

The Molicel Battery Pack is also referred to as the system battery. It provides operating 
power to the UltraLite for approximately 2 hours, when properly charged. See the 

Operation section, "Recharging the Batteries" for proper recharging procedures. 
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Initially, recharging may take as long as 16 hours, but subsequent recharging requires 
only 7 to 10 hours. 

NiCd Battery Pack 

The NiCd Battery Pack is also refered to as the Back-up Battery. It provides power to 
the silicon hard disk and lasts for approximately 5 to 7 days between charges. The 
recharging procedure for the NiCd Battery Pack is the same as for the Molicel Battery 
Pack. Since the life of the battery is 5 to 7 days of power, if the UltraLite will not be used 
for an extended period of time, the AC Adapter should be connected. 

Note: The AC Adapter cannot overcharge the batteries. Also, use of the UltraLite is 
permitted when the batteries are being recharged. 

LCD Panel 

The LCD Panel is a supertwist backlit LCD, with a 640 x 200 resolution (CGA standard). 
It also has a double-dot font capability which doubles the thickness of the characters. 
Through SETUP, the AUTO-POWER-DOWN Mode can be set. This is a power saving 
mode. In this mode, after 5 minutes of keyboard inactivity, the backlight will power 
down. Also in SETUP, the LCD Panel can be configured to be used at full brightness 
or half brightness. 

Power Supply (DC/DC Converter) 

The Power Supply converts the input voltages from the AC Adapter to aes V,-SV, +10 
V, -10 V, and -24 V. These voltages are used for logic (+5 V), modem circuits (+ 10 V, 
-1V), and driving the LCD panel (-24 V). Also +10 Vis used to develop approximately 
200 V AC required to drive the backlit EL Panel. 

EL Inverter Assembly 

The EL Inverter Assembly converts the inputted DC voltage to approximately 200 VAC. 
The AC voltage is then used to power the backlit EL Panel. 

EL Inverter Transformer 

The EL Inverter Transformer is used in conjuction with the EL Inverter Assembly to 
develop the 200 VAC for the backlit EL Panel. 
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UltraLite System 

EL Inverter Display Assembly 
Transformer 

FDD Box 

PC-17-31 Contrast 

EL Inverter 

Assembly 

Control 

Buzzer 

LCD 
Backlight DC/DC Parallel 

Converter Adapter 

LCD Panel 

Molicel 

Battery Pack MAIN PWB Power 

Control PWB 

NiCd 

Battery Pack 256K 

RAM Card 

Silicon 

Hard Drive 
512K 

ROM Card 

AC Adapter || Keyboard 512K 

Assembly ROM Card 
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3.2. Troubleshooting Guide 

The UltraLite Troubleshooting Guide is divided into three sections: 

@ Troubleshooting the DC/DC Converter and Power Circuits 

@ Troubleshooting the LCD Assembly 

@ Other Common Error Conditions and Solutions 

This guide also contains Power-On-Self-Test (Post) errors, an explanation of battery 
messages, and other basic troubleshooting techniques. 

3.2.1 Troubleshooting the DC/DC Converter and Power Circuits 

This section explains some of the situations that may occur when a unit is defined as 
having "no power". The following topics are discussed: 

@ How to identify which PWB in the power supply circuit is defective 

@ How to identify which battery is defective and how to test that battery 

@ How to identify a defective LCD Assembly 

@ How to charge the batteries correctly 

If the unit is running on the AC Adapter, check that the voltage outputs of the adapter 
are correct. The output voltages should measure 12 VDC at pin 1 and 5 VDC at pin 3. 
The CHG line, pin 2, should measure approximately 16 V. 

Note: The CHG indicator will turn ON only when the system battery (Molicel) is 
depleted. However, the LOW BATTERY indicator will turn ON when either the system 
battery or the backup battery (NiCd) is too low. 

Check to make sure the batteries are properly charged: 

1. Set the BACKUP POWER switches to ON. They are located on the bottom of the 
unit. 

2. Check to make sure the unit is turned OFF. 

3. Plug in the AC Adapter. 

4. While the batteries are charging, both the CHG and POWER lights should be ON. 

Note: The CHG indicator will always be ON when the AC Adapter is not connected to 
the unit. It will only turn OFF when the AC Adapter is plugged in and the batteries are 
fully charged. 

5. When the LOW BATTERY indicator, located on the UltraLite, and the CHG 
indicator, located on the AC Adapter, turn OFF, charging is completed. This may take 
16 hours initially, and subsequent charges may take 7 to 10 hours. The unit may be used 
while the batteries are being charged. 
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Identifying a Defective Battery 

If a battery is suspected to be defective, follow the above steps to recharge the batteries. 

NiCd Battery 

The NiCd battery is also referred to as the Backup Battery. It provides power to the Silicon 

Hard Disk. The charge in the battery will last approximately 5 to 7 days. If the NiCd battery 

is suspected to be defective, check the data on the Silicon Hard Disk. If the data is destroyed 

in any way, or if it is gone completely, replace the NiCd battery pack. When the unit ts not 

in use, the NiCd battery should be charged after every 5 to 7 hours of use. 

Molicel Battery 

The function of the Molicel battery is to provide power to the system. The charge in the 

Molicel battery lasts approximately 2 hours. Initially, the battery may take 16 hours to 

charge. Check to make sure it was charged properly. The Molicel battery has an output of 

12.6 V, 600 mA. A symptom of a defective Molicel battery is that the LOW BATTERY 

indicator never tums OFF, even after the CHG indicator has gone OFF. Another symptom 

is that the unit does not power up after proper charging or that the CHG indicator never 

turns OF F. 

Note: If the unit still does not charge the batteries properly, check to make sure the 

insulating tape and covers have been installed on the bottom of the MAIN PWB, and 

the top of the EL transformer. If these protective covers are not present, the batteries 

may draw excessive current, and damage the batteries. 

Measure the output of the internal DC/DC Converter. The output voltages should be 

+/-5V, +/- 10 V, and -24 V. Measure these voltages at pins 1 through 7 of connector 

PWROUT. This connector is located under the Keyboard Assembly. 

3.2.2 Troubleshooting the LCD Assembly 
Some of the sypmtoms of a defective LCD Assembly are: 

@ No backlight 

@ No display 

e No brightness or poor brightness control 

No Backlight 

Before performing extensive troubleshooting, check the following items: 

e@ Loose connections at the EL Inverter Transformer 

@ Loose input/output connector on the EL Inverter Assembly 

The LCD Assembly requires approximately 200 VAC to operate the backlight feature. 
This high voltage is developed at the EL Inverter Assembly and the EL Inverter 
Transformer. Check the voltages into the EL Inverter Assembly (PWB). The connector 
that should be checked is from the DC/DC Converter to the EL Inverter Assembly. For 
convenience, measure the voltages from the top to the bottom. The following are 
acceptable voltage levels: 

e+5V 

ee +5V 

@+9V 

e +30V 

If any of these voltages are not present, check for broken or disconnected cables. If there 

are no loose connections, replace the DC\DC Converter. If replacement of the DC\DC 

Converter doesn’t solve the problem, replace the EL Inverter. 
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To check the EL Inverter Transformer for 200 VAC, VERY CAREFULLY measure 
to see if the 200 VAC exists on the cable from the EL Inverter Assembly to the LCD 
Assembly. If the 200 VAC is not present, replace the EL Inverter Transformer. 

3.2.3 Common Error Conditions and Solutions 
The following is a list of the more common failures that are possible in the UltraLite 
along with solutions. 

BLUE SCREEN WITH A WHITE LINE DOWN THE MIDDLE OF THE SCREEN 

@ Defective or disconnected ROM PWB. 

ONLY BACKLIGHT FUNCTION OPERATES, BUT UNIT APPEARS TO BOOT UP 

@ Defective or disconnected LCD cable. 

@ Loose CONTRAST control. 

CHG INDICATOR ALWAYS ON 

@ Check/replace Molicel Battery. 

CHG INDICATOR TURNS OFF, BUT LOW BATTERY INDICATOR REMAINS ON 

@ Check/replace Molicel Battery and/or NiCd Battery. 

UNIT FAILS TO POWER UP USING BATTERY POWER 

@ Check/replace Molicel Battery. 

The following is a list of error messages (and possible solutions) that are displayed with 
a note "Error, press F1" whenever a hardware error is detected. To reboot the system, 
press the ALT-CTRL-DEL keys simultaneously. This resets the computer to its default 
parameters and may clear up any temporary problems. 

NO SCANCODE FROM KEYBOARD (XXh = SCANCODE, CHECK KEYBOARD) 

@ Check/replace Keyboard Assembly or Keyboard cable. 

BAD DMA PORT = XX 

@ Check/replace MAIN, ROM PWBs. 

ROM BAD CHECKSUM 

@ Check/replace MAIN, ROM PWBs. 

TIMER CHIP COUNTER 2 FAILED 

@ Reset the unit. This error may occur if the unit is turned ON, OFF, and then 

back ON again quickly. 

@ Check/replace MAIN PWB. 

DISK BAD 

@ Defective diskette/disk drive. 

@ Check/replace cables. 

DISKETTE DRIVE 0 SEEK FAILURE 

@ Check/replace disk drive. 

@ Check/replace cables. 

BAD RAM AT XXXX = XXH, EXPECTED = XX 

@ Check/replace MAIN PWB. 

UltraLite Maintenance and Service Manual 



TIMER OR INTERRUPT CONTROLLER BAD 

@ Reset the unit. This error may occur if the the unit is turned ON, OFF, and 

then back ON again quickly. 

@ Check/replace MAIN PWB. 

HARD DISK INITIALIZATION FAILURE HAS BEEN NOTED ... 

@ Check/replace Silicon Hard Disk. 

INVALID PARTITION TABLE. ERROR LOADING OPERATING SYSTEM. MISS- 

ING OPERATING SYSTEM 

@ Check/replace Silicon Hard Disk. 

DISK BOOT FAILURE. NON-SYSTEM DISK OR DISK ERROR. REPLACE AND 

STRIKE ANY KEY WHEN READY 

@ Defective diskette/disk drive. 

@ Disk (RAM Card) is without boot tracks. 

Low Battery Messages 

The following two messages are displayed when the system battery is too depleted to 

continue operation. The first message appears when the computer is turned ON; the 

second message appears during operation. When both messages appear, simply plug in 

the AC Adapter. 

POWER FAILURE HAS OCCURRED. 

PLEASE RECHARGE THE BUILT-IN BATTERY WITH THE AC ADAPTER. 

PRESS THE F1 KEY TO CONTINUE ... 

POWER FAILURE HAS OCCURRED. 

SAVE ALL DATA FILES IMMEDIATELY. PLEASE RECHARGE THE BUILT-IN 

BATTERY WITH THE AC ADAPTER. 

PRESS THE F1 KEY TO CONTINUE ... 

Note: If the first message appears immediately after powering up, check that the 

BACKUP BATTERY switches are both in the ON position. If they are in the OFF 
position, the same error appears, even if the batteries are fully charged. 

Troubleshooting Hints 

The following troubleshooting hints refer to the internal 2400 BPS Modem, LAP-LINK, 

and basic steps that should be performed. 

@ Disconnect all peripherals. 

@ When using the internal 2400 BPS modem, check to make sure the RJ11 

cable is plugged into the wall jack and the LINE Port and the telephone 

equipment cable is plugged into the TEL Port. 

@ If problems occur when using LAP-LINK, check the cable hookup and the 

floppy disk (formatted properly and the Write-Protect switch is set to 

UNPROTECTED). 

@ Check the CONFIG switches. 
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4. Disassembly, PC Board Identification, 

and Assembly 

Note: When working with an UltraLite unit, the technician should ALWAYS be 
grounded to an antistatic mat. Place the antistatic mat on the work bench and set the 
UltraLite on the mat. The strap should be attached to the technician’s wrist and to the 
mat. 

Required Equipment 

e@ Flat Head Screwdriver 

@ Phillips Screwdriver 

@ Long Nose Pliers 

@ Small Flat-Blade Screwdriver 

4.1. Disassembly 

Removing the Port Covers 

1. Turn the UltraLite over (bottom side facing up) 

2. Remove the following Port Covers: 

@ ROM Board Cover 

e SI-HDD Cover 

e@ Telephone Interface Covers (2) 

ROM Board Cover 

Si-HDD Cover 
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Telephone Interface Covers (2) 

Removing the ROM PWB and the Silicon Hard Disk 

1. Pulling upward, remove the ROM PWB. 

2. To remove the Silicon Hard Disk, hold the end of the Silicon Hard Disk, pull the 
Silicon Disk Drive upward slowly. 

Silicon Hard Disk 
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Removing the LCD Assembly 

1. Remove both Battery Covers and the batteries (NiCd Battery and Molicel). 

Molicel Battery 

Battery 

NiCd Battery 

2. Remove the eight black screws on the Bottom Cabinet. 

Screws (4) 

Screws (4) 
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3. Turn the unit over, open the LCD, and remove the RAM/ROM Slot Cover. Then, 
carefully lift up the Top Cover. 

NUL 
Note: The Top Cover cannot be removed completely at this time. 

Top Cover 

4. Remove the Keyboard Mounting screw and the green connector. At this time the 
Keyboard can be removed along with the RAM/ROM Card Guide. Nip 

Green Connector 

Keyboard Mounti 
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5. Slide the white LCD ribbon cable lock out, pull out the LCD ribbon cable. Disconnect 
the red connector. 

Red Connector 

6. Disconnect the Contrast Control Connector. 

Contrast Control Connector 
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Speaker 

7. Remove the two Ground Plate screws, then remove the Ground Plate. Carefully, lift 
up the Ground Sheet. At this point the LCD Assembly can be removed. 

Caution: Be careful with the Cabinet Latches, do not remove them from the Cabinet 
Bottom. 

Ground Sheet 

Ground P 

Ground Plate Screws 

8. Disconnect and remove the Speaker and Buzzer. These connectors are difficult to SE 
remove, use extra care in order not to damage the connectors. The small flat blade 
screwdriver may be useful when removing the connectors. 

Buzzer 
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Removing the DC-DC Converter and MAIN PWB 

1. Remove the three connectors attached to the DC/DC Converter. 

2. Remove one connector and the EL Inverter Transformer. 

Connectors 

DC/DC Converter 

JAE JOZO-EGOPA-LT1-A8 
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Screws 

3. Remove the nine screws attaching the MAIN PWB to the Bottom Cabinet, lift the 
MAIN PWB out of the Bottom Cabinet. NB 

= Screws 
Screws 

4. Remove the four screws attaching the DC/DC Converter to the Bottom Cabinet, lift 
the DC/DC Converter out of the Bottom Cabinet. 

Ni 

* Screws 

UltraLite Maintenance and Service Manual 



SL 

_——— 

5. Remove the one screw attaching the EL Inverter to the Bottom Cabinet, lift out the 

EL Inverter. 

Screw 
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4.2. Assembly 

Note: When re-installing the MAIN PWB, make sure the ROM Card Protector is seated 
inside the Bottom Cabinet. 

ROM Card Protector 

Installing the DC/DC Converter and MAIN PWB 

1. When installing the MAIN PWB, first install the Phone Jack connectors, then insert 
the MAIN PWB into the Bottom Cabinct. Fasten the MAIN PWB into the Bottom 
Cabinet with nine screws. 
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2. Insert the DC/DC Converter into the Bottom Cabinet, fasten it to the Bottom Cabinet 

with four screws. Attach "PWR IN" and "PWROUT" connectors to the MAIN PWB. 

Screws 

Screws 

3. Insert the EL Inverter into the Bottom Cabinet, use one screw to fasten it to the 
Bottom Cabinet. Connect the wire from the DC/DC Converter board. 

EL Inverter Assembly 

Screw 
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4. Install the Transformer and connect the cable. 

SI 
— Connector 

EL Inverter Transforme 

= x 2 Re xX 4 

Installing the LCD Assembly 

1. Install the Speaker and Buzzer. Use extreme care when attaching the connectors. A | 
long-nose pliers may be useful when attaching the connectors. lsat 

Buzzer 

Speaker 

M4 GS 

‘2 a 18 pe ee =: NIL 

; —)} re! See EE Fg weit? i Hes g- 2 
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2. Install the Ground Sheet and Ground Plate, fasten them with two screws. (Re-install 

the Cabinet Latches to the Bottom Cabinet, if necessary.) 

J 

Rs 

Ground Plate Screws 

3. Attach the Contrast Control Connector. 

Contrast Control Connector 
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4. Insert the LCD ribbon cable into the connector and slide the white portion of the 
connector in. 

Red Connector 

SER SLRS 

5. Install the Keyboard and RAM/ROM Card Guide, use one screw to fasten the 
Keyboard. Attach the green connector. 

Green Connector 
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6. Snap the LCD Assembly to the Bottom Cabinet and carefully turn the unit over. Make 

sure the springs of the cabinet latches are installed properly. (They should be straight, 

not bent.) 

LCD Assembly 

7. Fasten the LCD Assembly to the Bottom Cabinet with the eight black screws. Also 
replace the RAM/ROM Card Slot cover. 

Screws 

Screws 
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8. Install the batteries and battery covers (NiCd and Molicel Batteries). 

Molicel Battery 

NiCd Battery 

Installing the ROM PWB and Silicon Hard Disk 

1. Slide the Silicon Hard Disk into the Silicon Hard Disk Slot. 

Silicon Hard Disk 
ROM PWB 
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2. Slide the ROM PWB into the ROM PWB Slot. 

ROM PWB 

Installing the Port Covers 

Replace the following Port Covers: 

@ ROM PWB Cover 

@ Silicon Hard Disk Cover 

ROM Board Cover 
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@ Telephone Interface Covers (2) 

Telephone Interface Covers (2) 
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4 .3. UltraLite Parts List 
da eee en 

Sub-Assemblies 

Description 

MAIN PWB Assembly 
Keyboard Assembly 
Display Assembly (LCD) 
DC/DC Converter 
EL Inverter Assembly 
EL Inverter Tramsformer 
Speaker Assembly 
Buzzer Assembly 
ROM PWB 
1-MB Si-HDD (HMC-253C) 
2-MB Si-HDD (HMC-253B) 

Cosmetic Parts 

Bottom Cabinet 

HD Cover 

Battery Cover (A) 
Battery Cover (B) 
ROM Cover 

Memory Card Cover 
External Connector Covers 

Stopper Knob (L) 
Stopper Knob (R) 
Stopper Spring (2) 
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P/N 

A73-190133-5 
A73-160670-0 
A73-190135-5 
A73-152237-5 
A73-152251-5 
A73-152238-5 
A73-198698-5 
A73-778376-5 
A73-190134-5 

A73-180698-0 

A74-778861-5 
A74-778283-5 
A74-778280-5 
A74-778281-5 
A74-778282-5 

A74-778479-5 
A74-778299-5 
A74-778290-5 
A74-778303-5 
A74-778295-5 
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Accessories and Miscellaneous Parts 

Description P/N 

256K RAM Card PC-17-41 

3V Lithium Battery (RAM Card) 
AC Adapter A73-198687-5 
RS-232C Cable (Special) A73-167059-5 
Parallel Adapter PC-17-61 
Molicel Battery A73-160667-5 
NiCd Battery A73-160668-5 
3.5" Floppy Drive PC-17-31 
Phone Connector Covers A73-167056-5 
TEL Cable (A) A73-167057-5 
TEL Cable (B) A73-167058-5 
Diagnostics 
Maintenance and Service Manual 
Quick Start Guide 79060484 
Portable Guide 79060485 

Comprehensive User’s Guide 79060483 
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- Appendix A: 1/0 Connectors 

EXT Connector 

NUMBER SIGNAL FUNCTION 

GND Signal Ground 

a oe +S5SVDS EXT Equip. detect signal 

+5V +5V Power to Ext from UltraLite 

I/O Data Bus 

ABO ~ 9 
Address Bus (negative) 

+ 5V Power to EXT Equip. 

comes from AC adaptor through 
Ultralite 
Signal Ground | A34,B34 
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NUMBER | SIGNAL FUNCTION 

B9 RSTP Reset = ee Reset 
B10 | IRQ2 Interrupt Request Level 2 
ae eel Active High 
ABI UNC eee 

= Active High 

Me eae ee ee | Active High 
_Bl4 | GND Signal Ground 
‘BIS ~ - TOW I/O Write 

Active High 
B16 IOR I/O Read 

Active High 
DMA Request Level 1 
Active High 
DMA Acknowledge Level 1 
Active High 
DMA Request Level 2 

ees hs adiiad Active High 
B20 DMA Acknowledge Level 2 

ae eee Active High , 

wi Signal Ground * 
B22 MCLK V30 System Clock 

High Speed 9.8304MHZ (duty 50%) 
Low Speed 4.9152MHZ (duty 50% 

B23 Ve Terminal Count (DMA) 
a _ Active High 

B24 I/O CHCK I/O Channel Check 
ee a Active High 
B25 I/O CHRDY I/O Channel Ready 

High---CPU Wait 
bo tte dtpenduea eat Low---CPU Read 

B26 Address Enable 
High---CPU Mode 

ee Low---DMA Mode 
B27 DSRR Recognition of EXT Equip. 

I/O Port 1A2h (Read Only) 
D7= H: Exist 

| L: None 
B28 UltraLite Bus Buffer Control 

Active High 
B29 NC 
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Modem Port 

— 6-Pin Dupont BERG Modular Jack 

PIN NUMBER SIGNAL LINE 

Not Connected 

Not Connected 
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Telephone Port 

6-Pin Dupont BERG Modular Jack 

PIN NUMBER SIGNAL LINE 

Not Connected 

Not Connected 
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UltraLite RS-232 Connector 

1 

2 

3 
4 

5 
6 

7 

8 

9 
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FUNCTION 

RI (RING INDICATOR) 
TxD (TRANSMIT DATA) 
RxD (RECEIVE DATA) 
RTS (RETURN TO SEND) 
CTS (CLEAR TO SEND) 
DSR (DATA SET READY) 
SG (SIGNAL GROUND) 
DCD (DATA CARRIER DETECT) 
DTR (DATA TERMINAL READY) 
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Memory Card (RAM/ROM) Connector 

Oceann nn & WN 

FUNCTION 

Battery Check 
Card Signature 
Card Enable 
Write Enable 
Output Enable 

Upper/Lower 

Data 0 

Data 1 

Data 2 

Data 3 

Data 4 

Data 5 

Data 6 

Data 7 

Data 8 

Data 9 

Data 10 

Data 11 

Data 12 

Data 13 

Data 14 

Data 15 
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FUNCTION 

Address 0 

Address 1 
Address 2 
Address 3 

Address 4 

Address 5 

Address 6 

Address 7 

Address 8 

Address 9 

Address 10 

Address 11 

Address 12 

Address 13 

Address 14 

Address 15 

Address 16 

Address 17 

Address 18 

Address 19 

Address 20 

Address 21 

Address 22 

Address 23 
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ROM PWB Connector 

FUNCTION 

Signal Ground 

Host Romboard +5V Power 

Address Bus 

Lower Data Bus 

MERD Memory Read 
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FUNCTION 

Address for OTP or MASK ROM 

Add F4000 FFFFF 

CPU Address 
Add F0000 ~ F3FFF 

-I/O port OE4H Data 
OTP ROM Enable Low Active 
MASK ROM Enable Low Active 

A23 SELECT OTP/MASK Select 
OTP: Open 
MASK: End 

BIS,AS_ | GND«dL Signal Ground SSCS 

I/O Read Active Low 
1/0 Write Active Low 

BS DMA Acknowledge Level 3 Active Low 

B6 
DBM7 

I/O Data Bus 8-bit 

B15 CK9.8304M Clock 9.8304MHZ (Duty 50%) 

B16 CHRDY annel k eadyHigh-- ———<“Ci‘CS;:;7272373OW#*=:«é‘~S:*” 

CPU Ready Low---CPU Wait 
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Appendix B: Configuration Switches L 

The bank of four switches is found on the right side of the computer, in the same recessed 
compartment as the Memory Card Slot. These four switches control, respectively 

@ CPU Clock Speed 

e@ Built-in Test Program 

e Screen Brightness 

@ The thickness of the characters displayed on the screen 

To verify the switch settings: 

1. Remove the Memory Card Slot cover by pulling gently. 

2. Make sure all switches are in the UP (Off) position. 

CONFIG switch summary 

switch controls default (UP) alternate 

1 CPU Speed High (9.83MHz) Low (4.92 MHz) 

Z Test Loop Off Running 

b) screen bright Dim 

4 characters thick thin . 

CONFIF SW 2 makes the computer inoperable, it places the system in a continous test 
loop when in the down (ON) position. 

The CPU clock speed, screen brightness, and character thickness can also be set with 
the built-in SETUP ae To avoid conflicts, it is recommended to use the SETUP 
program to change these settings. Under normal circumstances, the CONFIG Switches 
should never be changed. Before using the UltraLite, verify the switches are in their 
default positions. 

If any of the switches are changed while the computer is ON, the unit must be turned 
OFF and then ON for the new settings to take effect. 

Note: The Configuration switches take precedence over any settings made with the 
SETUP program. 
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Appendix C: UltraLite Memory Ma 

FFFFFyY 

F4000H 

FOOOOH 

MEMORY CARD SEE NEXT 

BANK (64KB) PAGE MASKROM (512KB) 

E0000H 
80000 

60000 

| CO00H 
= VRAM (16KB) 40000 
B8000H 

20000 

AO0000H 

MAIN MEMORY 

(640KB) 0 

000001 
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Memory Address Map for Memory Cards 

CPU MEMORY MAP 

BANK 
EFFFFH ADDRESS 

MEMORY CARD 25 
BANK (64KB) 

254 
E0000H 

253 

17 
1M ROM CARD 

16 

15 

14 
26KRAM 
CARD 
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Appendix D: Keyboard Layout 

Escape 
Key 

IC 
| Lock | 

Ji J) | — 

Tab tssnitt [Zz [x |fe ]fv | ee | 
Key 
Caps 
lock 

Ctrl 

Break Delete 

flere re f 
Sys Req | | |i 

5 } LES } [Fe 

am TF 

| |i | || vel 
y IL 4 2 

if 

@ |/# js ie r || iW) 

13. 
Tab|~« ) 

>| | 

| | | HT? ie Hi F I} Q | ye WR it i U Ike 1 mi 
| } 5) | 5y | an | | JL t j 

= 

[caps A i 1] D 

| | 

i 

| | Ctrl | 

Er Alt Keys 

Embedded Keypad 
(Depress the Num Lock Key to access) 
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Appendix E: Internal Software Error 
Codes 
SESS ESSE SSS ers 

90 

Appendix E contains the error messages generated by the internal software programs. 

SETUP Messages 

The SETUP program has one error message which appears when the PALETTE 
command is selected with the Color Parameter set to Emulation Mode. Color must be 
set to Contrast Mode in order to use the PALETTE command. 

You cannot execute this command when Color Mode is set to Emulation. Press any key to 
continue. 

MS-DOS Manager Messages 

Note: Press the F1 function key for more information when MS-DOS Manager displays 
an error message on the screen. 

Cannot change directory to dir 

The directory specified does not exist in the path specified. Check to make sure the 
correct path for the directory was entered. 

Cannot copy FILENAME to itself 

MS-DOS Manager cannot make a copy of a file in the same directory without a new 
name for the file. A new name probably was not entered. Enter a new name and try to 
copy the file again. 

Cannot copy multiple files to a single destination 

MS-DOS Manager cannot copy a set of source files specified with the wildcard character 
(*) to a single target (or destination) file or to a directory that does not exist. To copy 
the files to anew Teo. first create the directory; then copy the files to that directory 
using wildcards. Keep in mind, MS-DOS Manager cannot combine more than one file 
into a single file. 

Cannot create directory 

The name given for the new directory is either invalid or already exists. Try again using 
a different directory name. 

Cannot create FILENAME 

MS-DOS Manager cannot create the file requested either because an invalid filename 
was specified or the disk is full. Use the DISK INFO command to check the disk for 
amount of available space. If there is enough space on the disk, try specifying a different 
name for the new file. 

Cannot delete FILENAME 

MS-DOS Manager cannot delete the file specified because the file has read-only 
attributes. The file has read-only protection and is not intended to be modified. 
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Cannot find FILENAME 

MS-DOS Manager cannot locate the file that is to be copied, moved, or renamed. Make 
sure the correct path was specified for the file, or use the LOCATE command to find 
the correct pathname. 

Cannot move FILENAME 

MS-DOS Manager was instructed to move the file to a file that is invalid or already exists. 
If the file that is to be moved is on a floppy disk, first check to see if the disk is write 
protected. If not, try using the MOVE command again using a different filename. 

Cannot perform this operation on a device 

MS-DOS Manager will not allow a device file to be deleted. 

Cannot read from drive n: 

MS-DOS Manager cannot access a formatted disk in the disk drive specified. Make sure 
the specified drive contains a formatted disk. Also check to see if the disk or RAM/ROM 
Card is inserted correctly. Then, try the operation again. 

Cannot rename FILENAME 

When MS-DOS Manager prompted to rename a file, a filename that was invalid or 
already existed was used. Try using the RENAME command again with a different 
filename. | 

Cannot run FILENAME 

A file that is neither executable (it does not have a.BAT, .COM, or .EXE extension) nor 
has an extension belonging to one of the installed applications was trying to be run. If 
the file is an application file, use the Modify Application List command to add the 
filename’s extension to that application’s list of extensions. 

Insufficient disk space for this application 

The disk being used for the copy or move operation does not have enough free space for 
the new file. Free up some disk space by deleting any files on the disk that are not needed 
anymore, or copy or move the file to a new disk. 

Insufficient memory available to complete this operation 

MS-DOS Manager cannot complete the command request because there is not enough 
free space in the computer’s internal memory. 

Invalid date format 

The correct format was not used when the date was entered. Try entering the date again 
using the format mm-dd-yy, where mm is the month, dd is the day of the month, and yy 
is the last two numbers in the year. 

Invalid time format 

The correct format was not used when the time was entered. Try entering the time again 
using the format hh:mm[AM/PMl], where hh is the hour and mm is the minutes. 

Please specify a filename at the prompt for this operation 

The name of the source file for the operation was not entered. Try the operation again, 
and enter the name of the source file. 

MS-DOS Manager cannot rename a file across disk drives 
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The RENAME command cannot be used to copy a file to a new disk and be renamed at the same time. Copy or move the file to the new disk, then rename it. 

To delete a directory, all files in the directory must be deleted first. 

The options are set for directories to be empty before they can be deleted. MS-DOS Manager will not delete a directory if there are any files in it. Either delete the files in the directory before deleting the directory or change the options in the Delete Options command so MS-DOS Manager can delete directories that are not empty. 

Wnite-protect disk in drive n: 

The files on the disk cannot be modified (written to or editted) because the disk has been protected. Copy the files that are to be modified to a disk that is not write-protected. Or, disable the write-protection by sliding the plastic tab over the write-protect window in the lower lefthand corner of the disk. On a RAM Card, flip the tiny switch on the back of the card to the correct position. 

Lap-Link Messages 

There are two kinds of Lap-Link error messages: 

@ Critical 

@ Status, Alerts 

Critical Error Messages 

Three critical errors will pause LAP-LINK and require corrective action. If one of these 
critical errors is encountered, a message appears on the screen with information con- 
cerning the problem and asking for the next steps to be taken: Retry, Ignore? Press R 
to retry the command or I to ignore the command and resume the program. (I may need 
to be pressed several times). Critical error messages appear only on the computer at the 
time the problem occurs. 

Drive A: not ready 

Retry, Ignore? 

Either there is no disk in the drive, the disk is not formatted for that computer, or there 
is a bad sector on the disk. 

Drive x: write protected 

Retry, Ignore? 

For 5 1/4" disks, remove the ee tab. For 3 1/2" disks, move the write-protect 
tab so the window is closed. For UltraLite RAM Cards, flip the write protect switch on 
the back of the card. Then, press R to continue. 

General failure error 

Retry, Ignore? 

The most common cause of this message is a bad sector on the disk. Retry once or twice 
to correct the situation. If that fails, press I until the program resumes; then exit and 
track down the problem. 
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Status, Alert Error Messages 

The other type of LAP-LINK error messages are status and alert error messages. Most 

appear in the message line of the LAP-LINK screen, others appear as part of the report 
LAP-LINK issues while copying files. 

Cannot erase default subdirectory 

The ERASE-DIR command was used in the directory tree to erase the currently logged 
directory (highlighted on the screen). Use the LOG command to log onto a different 

directory and try again. 

Cannot erase NAME 

NAME is the name of the directory or the designation for either the root directory (.) 

or the parent directory (..). Like MS-DOS Manager, LAP-LINK will not erase a 
directory that contains subdirectories. Under no circumstances can the root directory 

be erased. 

Cannot find LL.*EXE. Your Options settings were not saved. 

An attempt to save the current settings of the Options Menu was made, but LAP-LINK 

could not locate its operating program, LL.*EXE, on which the settings must be saved. 

On a remote floppy disk system, be sure the disk with the working copy of LL.*EXE is 
in the currently logged drive. On a hard disk or a floppy disk with more than one level 
of directories, you must be logged onto the directory in which LL.*EXE is stored. 

Cannot find path NAME 

An attempt to log onto a directory that does not exist was made. Reactivate the LOG 
command and type the correct drive, pathname, or both. This error also occurs when 
in the root directory and an attempt is made to move to the parent directory by entering 
".." after activating the LOG command. 

Cannot rename a subdirectory ... 

LAP-LINK doesn’t allow subdirectories to be renamed. Use MS-DOS Manager’s 
RENAME command under the File Menu. 

Cannot rename FILENAME 1 to FILENAME2 

either FILENAME1 or FILENAME? is an invalid filename or FILENAME? already 
exists in the current directory. 

Cannot restart. No previous Wildcopy 

The WILDCOPY command has already been activated and =r as the file specification 
was entered without having a Wildcopy process aborted. The =r specification can only 
be used after a Wildcopy process has been aborted because the ESC key was acciden- 
tally pressed or LAP-LINK experienced trouble in the copy process. 

Cannot view a subdirectory 

The VIEW command only works when the highlighted bar selects a file. 

Checksum error on block xxx 

Anerror occurred while LAP-LINK was attempting to send or receive a block of data. 
The block will be resent until it is received correctly or until there are 10 consecutive 
errors, at which time the COPY command will be aborted. This error should not occur 

often; if it does, the fault may be with the cable (it may be too long) or with one of the 
serial ports (it may be limited in the baud rate at which it can be operated). Use the 
BAUD option to lower the baud setting. 
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Checksum error on header block 

An error occurred while LAP-LINK was sending or receiving the header block of a file. 
(The header block contains the name, size, date, and other information about each file.) 
The block will be resent until it is received correctly or until there are 10 consecutive 
errors, at which time the COPY command will be aborted. Retry the operation. If the 
error persists, try setting a lower baud rate using the Baud option or shorten the 
LAP-LINK cable. 

Copy aborted. Press any key to continue ... 

This message appears whenever a copy operation is aborted. If the cause is a full target 
disk, "Target Disk Full! Use Wildcopy to continue..." also appears. 

The ESC key may have been pressed accidentally. The COPY operation can continue 
where it left off: Press any key to return to the LAP-LINK screen. Insert a new formatted 
disk if the current disk is full, then press W Y. 

Could not erase name 

The ERASE command in Group cannot erase a hidden or read-only file. Use the 
Primary ERASE command to erase the file. 

Could not find COM1: (or COM2:) Switching to COM2: (or COM1: ) 

Press any key to continue ... 

The Serial Port specified by the Communications Port option in the Options Menu may 
be incorrect. The UltraLite port should be COM1:, the port on the remote computer 
may vary. 

Could not find COM2: (or COM1:) Right window switching to Local ... 

Press any key to continue ... 

This messages appears only after the previous message. It means the computer has no 
COM1 or COM? Serial Port. When any key is pressed, the LAP-LINK screen appears, 
but both the right and left windows will be displaying files only for the local computer. 
Without either serial ports, only the files on the Iocal computer can be managed. 
Communications with another computer through LAP-LINK is not possible. This 
message only occurs on the remote computer. 

Could not find DRIVE\PATH\FILENAME 

LAP-LINK could not find the specified file or files. 

Note: If LAP-LINK has been directed to include subdirectories in a copy, this message 
appears once for each subdirectory in which the specified file does not exist. 

Could not find startup name 

After an aborted COPY operation with the WILDCOPY command, the operation has 
been restarted. But, LAP-LINK cannot find the startup file with which it will resume 
the operation. LAP-LINK may not locate this file because it has been moved, renamed, 
or is stored in a subdirectory of the current directory and the COPY FROM SUB- 
DIRECTORIES is set to NO. 
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Error on block xxx 

See Checksum error on block xxxx. 

File create error 

LAP-LINK could not create the file. If the directory is full, either erase files to make 

room or copy to another directory or disk. 

File exists! Overwrite it? (Y/N)N 

Through the Confirm Before Overwriting option, LAP-LINK has been instructed not to 

copy over files of the same name without confirmation. Press Y to copy over the file; 

press any other key if the file should not be copied over the ier file. To instruct 

LAP-LINK not to ask for confirmation before overwriting files of the same name, set 

the Confirmation Before Overwriting option (in the Options command) to NO. 

FILENAME is marked as read-only. OK to erase? (Y/N) N 

This message is intended to keep read-only filed from accidentally being erased. Ifa 

read-only file is to be erased, press Y. 

File (s) not within specified time frame. Not copied! 

During copying, this message appears for each file that does not fit within the time frame 

specified by the COPY DATE RANGE and the COPY DATE options. To remove the 

time frame, activate the OPTIONS command, move the highlighted bar over COPY 

DATE, press any numeric key, and then press ENTER. As long as mm/dd/yy is listed 

for this option, files will not be selected by date or time. 

LAP-LINK: Not enough memory ... 

There must be at least 197,000 bytes of free memory to run LAP-LINK 

Press any key to continue ... 

Torun LAP-LINK, there must be at least 197,000 bytes of free memory on the computer. 

Use the DOS command CHKDSK. The value for bytes free listed at the end of the status 

report should read approximately 197,000 or more. 

NAK error on block xxx 

See Checksum error on block xxxx. 

NAK error on header block 

See Checksum error on header block. 

No tagged files found ... 

The COPY or ERASE commands have been selected within the Group command 
without having tagged any files. 

Not enough room for command processor or COMMAND.COM not found... 

Press any key to continue ... 

If the System disk has been removed since booting the computer, replace the disk and 

try again. 
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Remote system in control ... 

This message appears on the screen of either computer when a primary command has been selected on the other. Each machine regards the other system as remote and itself as local. 

Remote system not active ... 

There is no communications with the remote computer. There are several possible causes: 

@ The cable may not be connected correctly. 

@ The baud setting (Baud Option) may not be the same for both computers or 
is set too high. 

@ The designation of the Serial port is incorrect. (Communications Port 
Option) 

@ The remote computer may have locked up or has quit out of the program. 
Check the ADDRESS and INTERRUPT switches/jumpers on the COMMUNICA- TIONS PWB to ensure the switches/jumpers are set correctly. 

Sector error count on block xox 

A COPY operation failed at the specified block count. LAP-LINK will resend the block 
until the sector error count is correctly received or until there are 10 consecutive errors, at which time the COPY command will be aborted. 

Source file is older than target file. Not copied! 

If the COPY NEWER FILES ONLY option is set to YES, this message will appear for 
each file that is not copied from the source disk because it is older than the copy of the same file on the target disk. Set the COPY NEWER FILES ONLY option to NO to 
overwrite files on the target disk without considering whether they are newer or older. 

Target disk full! Use Group Copy to continue ... 

More files that can be copied to the target disk have been tagged. Press a key and insert 
a formatted disk into the target drive. Remain in the GROUP command and press C to 
copy files still tagged. 

Note: Files already copied to the target disk no longer are tagged. 

Target disk full! Use WILDCOPY to continue ... 

See COPY aborted. Press any key to continue ... 

Target file is read-only. Not Copied! 

An attempt to copy a file that already exists on the target disk as a read-only file was made. LAP-LINK will not allow this filc to be overwritten. 

Target file is unmodified. Not copied! 

If COPY NEWER FILES ONLY option is set to YES, this message appears for each 
file that is not copied from the source disk because it is not different from the copy of that file on the target disk. (The dates and times match exactly, to the nearest two seconds.) Set the COPY NEWER FILES ONLY option to NO to overwrite files on the target disk without considering whether they have been modified. 
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Timeout error 

LAP-LINK did not get a timely response during the copy process. It will try again, up 

to 10 times, before aborting. This message will appear if the target disk is very slow or 

if either drive went offline during the copy process. 

Modem Error Conditions 

Double printing of your keystrokes 

The UltraLite is probably set to HALF DUPLEX and the unit is connected to a remote 

system that is echoing the input. Select FULL DUPLEX from the Communications 

program. 

Call cannot be completed as dialed 

Has an outside line been obtained, dialed 1 for long distance, and chosen pulse or tone 
dialing? 

Has the modem directory been reset with the correct area codes to dial from the present 

location? 

No carrier message 

The No carrier message appears when the telephone connection between the UltraLite 
and the remote computer has been broken. This can be due to several causes: 

@ The remote computer terminated the session normally, because of incorrect 

passwords, a long period of inactivity on the line, etc. 

@ The remote computer failed or the telephone connection failed. 

e An incoming call under CALL WAITING SERVICE confused the modem 

program. 

UltraLite won’t answer incoming call 

The modem’s S-register, SO, defines when to answer an incoming call. To answer on 
the first ring, set SO = 1. 

Unable to place call 

The UltraLite phone cable should connect the LINE socket on the back of the UltraLite 
to the telephone wall outlet. The cable may be connected to the PHONE socket on the 
UltraLite or to an incompatible connector. 

For more information concerning the internal 2400 BPS modem, see pages 149 -171 in 
the Comprehensive User’s Manual. 

Unable to see what was typed 

If messages are received from the remote computer, but text typed on the UltraLite 
cannot be seen, one of two things can be done: 

@ Select the HALF DUPLEX mode from the communication program. 

@ Request the remote computer to echo the transmission. 

UltraLite Maintenance and Service Manual 97 


	ultralite_1
	ultralite_2
	ultralite_3
	ultralite_4
	ultralite_5

